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Introduction








Microsoft Excel is a well-known spreadsheet software from Microsoft. This is intended for all Mac OS and Windows computers. It has a user-friendly interface and a range of tools for quickly and easily evaluating data. Excel has become one of the most famous software systems globally due to a strong marketing effort. Excel is usually included in the Microsoft Office software package.



Microsoft Excel is among the most widely adopted software applications in the world currently, and it is part of the Microsoft Office Suite, which also includes other applications. Because of its adaptive and modular functionality, this app has replaced chiefly Lotus 1-2-3 as the industry standard for spreadsheets. While Microsoft Excel was not widely recognized in the late 1980s, it has since become the most commonly distributed program, despite competition from various companies, especially Google. Nonetheless, Microsoft made a mark with the release of Excel, which is still one of the most common software products in the world, second only to Windows. This software has outstanding estimating techniques that can also be applied to graphics. Multiplan, on the other hand, would not have had the same influence if it hadn't been the mentor that started it all.



Because of its features to carry out certain mathematical, financial, and statistical operations that might have become cumbersome if performed manually, Microsoft Excel has become a sought-after technology in large organizations worldwide. With the usage of Microsoft Excel, time and resources are saved for more productive work.



With the way the world is changing, businesses are searching for people who aren't only computer literate but also have a broad understanding of how to use Microsoft Excel. For this purpose, as an individual, you can't afford to waste out on a career opportunity because you don't know how to use Microsoft Excel.



Microsoft Excel isthe application that executives and department heads useto prepare their employees to become familiar with maintaining the seamless operation of those organizations and, most importantly, to increase job efficiency both inside and outside the organizations. To be realistic, learning and using Microsoft Excel is not a simple task. The majority of people find it challenging to use, but Microsoft Excel would be taught in an easy-to-understand and use pattern with this user guide.



Excel 2021 is spreadsheet software that allows you to deal with data efficiently and accurately. It has much of the same features as the other Excel versions. It includes various tools for handling and manipulating data, such as representing datausing Charts and more. If you want to revisit or brush up on your Excel skills, whether you've never used it yet, you'll discover this book for the basics of this spreadsheet program, like how to deal with rows, columns, data formatting, basic formulas, and functions. There are a few new features in Excel 2021 that you'll notice. Aside from that, you'll learn about the text, numeric, and logical functions, among other things.









 
Chapter 1:

 
Basics of Microsoft Excel








For more than three decades, Microsoft Excel has become the most widely used spreadsheet application in the world. Excel, unlike presentation software, has functions and resources for rendering calculations and graphs, allowing you to use it for anything from household budget preparation to inventory management. It was created by Microsoft Corporation and had several exclusive features that set it apart from previous versions. If you're new to Excel, let's take a short tour of what it's all about before diving into Excel 2021 and its core functions.



1.1
 
 
 
What Is Microsoft Excel?




Microsoft Excel is a spreadsheet application for gathering and processing numerical and statistical details. Microsoft Excel includes various tools for performing tasks such as calculations, pivot tables, graphing tools, macro programming, and more. It works for different operating systems, including Windows, Mac OS, Android, and iOS.



A table is created by a series of columns and rows in an Excel spreadsheet. Columns usually are allocated alphabetical characters, while rows are typically assigned numbers. A cell is the intersection of a column and a row. A cell's address is determined by the letter representing the column and the number representing the lines.



The illustration below depicts the design of an Excel spreadsheet:


[image: ]



1.2
 
 
 
A Historical Look Into Excel




The Microsoft Corporation developed Microsoft Excel in 1984. It was designed to provide users with a more convenient way to measure data without using the DOS command line. It was launched to be used on Apple computers. When Microsoft Windows was first released in 1987, one of the first applications developed for it was Microsoft Excel. Until 1992, it was the first windows-based table software. Microsoft Excel provides several different versions with three other operating systems. From 1985 until now, Microsoft Windows has had 29 different versions.



Let's look at some of the ways Excel (then in the 80's known as Multiplan) has evolved through the years.



Multiplan AKA Excel in the 80s



Multiplan was created to work on CP/M and MS-DOS systems, and it was constantly updated during the first few years of use to keep up with VisiCalc. It was called Excel in 1985 and added a graphical user interface. It could only be used for Apple Mac computers at that time, introduced in 1984, just before the first Windows computer. Excel 2.0 was re-engineered into this new platform after Microsoft first implemented its computer and operating system in 1987.



To give you an idea of how far Excel has progressed, the user experience has been constantly updated up until now. Through an online tool available here, you can now transform PDFs to Excel documents in a streamlined manner. The PDF format had not yet been introduced before Excel was adopted, and it was not invented until 1993.



Excel in the 1990s and Its Massive Improvements



Drawing capabilities, toolbars, add-in assistance, outlining, 3D charts, and several other features were included in the run-time edition of Windows in 1990. This redesign has seen a significant increase in the software's functionality, but advancements in the 1990s didn't end there. The first “popular” edition of the app, released in 1992, featured several usability features. Multi-sheet workbooks and VBA support were added in 1993, making it a significant update (visual basics for applications).



Both Windows 95 and the most famous Excel, Excel 95, were released in 1995, and both featured support for 32-bit versions. In terms of features, it was identical to Excel 5 in 1993, except that the interface was marginally improved. Then came Excel 97, which came with a modern VBA interface for users, data authentication, User Forms, and a slew of other enhancements.



Excel in the 2000s and Excel 2000, 2002, 2003 and 2007



Excel 2000 was introduced in 1999, and it could use HTML primarily as a native format, allowing users to enter related commands on HTML-based web pages. Clipboards, self-repair, modeless user types, and pivot charts may all be improved with Excel 2000. Excel 2002 was used in the Office XP suite, and it included Publisher, Word, and PowerPoint, two of which are still in operation today. The average consumer did not see the majority of the latest additions. Excel 2002, on the other hand, had a function that saved the work if the software crashes.



Shifting on to Excel 2003, the latest additions were much more impressive than the previous version. The list range functionality was added, Smart Tag was introduced, and the interface's mathematical function and XML support were enhanced. Another upgrade was released in 2007, but it wasn't significant; it was only introduced to fix certain graphical flaws and program malfunctions.



Excel in the 2010s and Beyond



The changes since 2010 aren't as significant. It doesn't mean Excel is a perfect application, but it has undergone several enhancements and modifications in recent years that have changed the spreadsheet format. Better graphical features upgraded pivot table slicers, Solver, and a new and enhanced 64-version needed to run on Vista and the soon-to-be-released Windows 8, all added in 2010. Finally, charting improvements, a single-document design, and instructions for users to select between pivot tables and maps were included in 2013.



Instead of adding or eliminating functionality, Excel also updates the user interface consistently for the latest versions. Minor and big bug fixes and security upgrades and maintaining device compatibility for recent iterations of Windows OS are expected to be a constant feature of Windows programs.



Excel 365



Excel 365 is an ever-evolving offering, with different enhancements introduced with each new version, rather than the typical three-year update period. Since business consumers don't want constant updates and prefer rock-solid, reliable upgrades, Microsoft invented "update channels" for Office 365. Signing up for a six-month upgrade channel is recommended for enterprise users. This resulted in a solid and tested "Semi-annual" edition in January and July of each year.



According to Microsoft, the Office (Long-Term Servicing Channel) LTSC edition will have compatibility enhancements, dark mode support, and features like XLOOKUP and Dynamic Arrays. In Office 2021, similar functionality will be open.



The dark mode is by far the most significant change, but the rest of the configuration and cloud-based capabilities will appear to be prioritized for Microsoft 365 Office versions.



In Excel 365, many older Excel functions can be used in entirely new forms, and some old standbys have been replaced with new array-aware parts. XLOOKUP, for example, has taken the place of VLOOKUP.



Since the beginning of 2019, Excel 365 has acquired some amazing features, but nothing competes with the inclusion of Dynamic Arrays functions in the updated upgrade version. This isn't a slight modification. The Excel engines had to be re-engineered to embrace the idea of the new dynamic series. Thanks to the new complex array features, Excel 365 has moved to a different standard from Excel 2019. Since dynamic arrays are incompatible with Excel 2019, modern workbooks (created with Excel 365) would fail to work as expected in older models (Excel 2019 in this context is a legacy version, although one may still purchase it).



Excel 365 is the newest, latest, and perhaps most potent Excel version available, and it's just a few dollars a month.



1.3
 
 
 
What Is Excel Used for?




Microsoft Excel is used to keep track of results, store it, analyze it, and present it. In Excel Cells, you have to insert data in Dates, Strings, or Numerical values and then save the files for possible future reference. Here are the most common uses of Excel:



	
Accounting


	
Data entry


	
Financial analysis


	
Data management


	
Customer relationship management (CRM)


	
Programming


	
Charting and graphing


	
Time management


	
Financial modeling


	
Task management


	
Anything and everything that needs organizing!





1.4
 
 
 
Where Is Excel Used?




Microsoft Excel is widely used in nearly every industry. Here are few examples of real-time Excel realms and industries:



	
The financial industry makes extensive use of various types of estimates.


	
For the application of simple analytical methods and resources, analytical professionals use Excel nearly every day.


	
The banking industry makes use of customer understanding.


	
Retail Associates analyses POS statistics to see if prices have changed and trended.


	
Daily, Weekly, Monthly, Quarterly, and Yearly Reports are generated by Reporting Analysts.


	
Healthcare Teams carry out the longitudinal research study.


	
Marketing Experts use it to figure out the frequencies and totals.


	
VBA Developers use it to create Office applications, tools, add-ins, and dashboards.





1.5
 
 
 
Features of MS Excel




Excel's features that make it the most widely used application are as follows:



Graphical Features of Excel



Excel has a wide range of interactive features for representing data through charts and graphs. Shapes, Clip Arts, Smart Arts, Charts, and Pictures are among the examples.



Database Features of Excel



Excel could be used as a database and for a variety of data processing tasks. Slicers, Pivot Tables, Sparklines, Tables, data analysis, Databases and sorting, data validation, filtering, grouping, data protection, data recovery, online data storage, and access, and many more.



Functional Features of Excel



Excel Tools and Functions will assist you in performing complex calculations and enhancing the features of the Excel application. VBA Macros, Mathematical Formulas, Add-ins, Conditional Formatting, Hyperlinks, Security, and Spell Check are only a few examples. Here are a few of the most common.



	
AVERAGE function:
 The arithmetic mean of the arguments is returned. If the set A1:A20 includes numbers, then the formula =AVERAGE (A1:A20) is used to replace the mean/average of the numbers in that range.


	
SUM function:
 Values are added. Specific values, cell references, and ranges, and a combination of all three can be added.


	
COUNT function:
 The range of cells that hold numbers is counted.


	
MAX function:
 The highest value in a series of values is returned.


	
MIN function:
 The lowest number in a series of values is returned.





1.6
 
 
 
Terms and Jargons for Microsoft Excel




Excel is one of the most flexible options currently. It can do anything from simple data organization to more complex arithmetic operations for technical or financial purposes. Although the program's primary functions are simple to grasp, it does include certain jargon that could be confusing to newcomers. Here are few words used by Excel to help people understand the program's core features.



Workbook



Workbooks are Excel files that contain one or more worksheets. The workbook is labeled as Book 1 accordingly. The Excel file will be saved under this title if the name is not modified. Consider it a ledger book for accounting.



Worksheet



A worksheet is a sheet that may hold one or more data tables. Consider it a page in a book of accounts, one of many.



When you start working with a new workbook, you almost always have three worksheets. To uninstall a worksheet, right-click on it and select Delete. Click on Add Worksheet option to begin adding worksheets.



Excel worksheets are distinct entities, and each worksheet is autonomous of the others. A formula that refers to several worksheets is possible.



Ribbon



Above the work, the region is the Ribbon, which is a series of keys. The Ribbon can only be used in Excel 2007 and later versions. It takes the role of the previous version's menus and toolbars.



Insert, Home, and Page Layout is only a couple of the tabs on the Ribbon. The choices connected with this portion of the Ribbon are shown when you click on a tab.



Cell



Every rectangular box inside a worksheet is referred to as a cell. They may have details or formulas in them.



The cell that is currently selected is known as an active cell or present cell. A dense black outline distinguishes it.



Name Box



The Name Box displays the active/current cell's name and the names of a defined number of cells or table.



By selecting it and modifying the name in the Name Box, all cells, or some cells (a table) can be named. However, each worksheet may only have one cell/table of the same name.



Cell Reference



The Cell Reference displays the name of the currently selected cell or table, i.e., the current/active cell or table. The Name Box shows cell references.



Formula Bar



The active/current cell's contents are shown in the Formula Bar.



If the active/current cell contains a formula, the Formula Bar will display the formula, while the active/current cell will demonstrate the overall estimated result (which could be a phrase or number).



Formula



The opportunity to use formulas is among Excel's most advanced features. You can use procedures to perform automatic calculations inside worksheets and also within workbooks.



A formula must start with an equivalent (=) sign and be typed into the formula bar. You can use procedures to perform any of the four primary mathematical operations (add, deduct, multiply, and divide), or you can use brackets to specify the order in which the formula should be solved, or you can use any of Excel's hundreds of built-in functions.



Functions



Excel functions are pre-programmed calculations. Consider functions as a more convenient way to construct formulas. They're made to make potentially complicated formulas in a worksheet easier to understand.



Array/Range



Arrays/ranges are simply groups of cells that have been clustered together. The array/range used in the SUM formula, for example, is A1:B1, which informs the formula to interpret from A1 to B1.



In the first and last cells of an array/range, a colon (:) is used to indicate the array/range. They can also be used to call up cells in
 Tables
 ,
 Rows
 , and
 Columns
 .



1.7
 
 
 
Excel Tools




There are several tools in Excel that have rendered it easier and more efficient to use. Microsoft Excel has developed menus and tools to assist Excel customers with further customizing their spreadsheets and workbooks. The easy access toolbar was designed to allow users to easily access commonly used commands. This toolbar can be customized using the Excel application or a related workbook. Excel also created the Ribbon to substitute the original Excel menu templates. Users of Excel were able to tailor the belt to suit their specific needs.



1.8
 
 
 
File Formats That Are Supported in Excel




The format types or file types in Excel are crucial since they inform you about the files before you open them and allow you to save them as macro-enabled files, binary files, templates, and so on. Furthermore, Microsoft Excel also introduced novel ways to save workbooks and other Excel applications. The import and export feature allows Excel users to easily import workbooks, data, and export workbooks or files that have been already created and can be used later.





	

.xlam



	

Excel Add-In



	

Excel latest versions, Excel 2019, 2016, 2013, and Office Excel 2007, use the XML-based and macro-enabled Add-In format. An Add-In is an application that operates additional code in addition to the main programmed. VBA assignments and macro sheets Excel 4.0 are supported (.xlm).






	

.xls



	

Excel 97-Excel 2003 Workbook



	

Binary file format for Excel 97-2003.






	

.xls



	

Microsoft Excel 5.0/95 Workbook



	

Binary file format for Excel 5.0/95.






	

.xlsb



	

Excel Binary Workbook



	

The latest Excel versions, Excel 2019, 2016, 2013, 2010, and Office Excel 2007, use the binary file format. This is a convenient load-and-save data format for those who need to load data files as quickly as possible. VBA assignments, macro sheets Excel 4.0, and many of Excel's latest updates are supported. However, since this isn't an XML file format, it's not ideal for viewing and editing information without Excel 2019, 2016, 2013, 2010, or 2007 and the object model.






	

.xlsm



	

Excel Macro-Enabled Workbook



	

Excel 2021, 365, 2019, 2016, 2013, 2010, and 2007 use an XML-based and macro-enabled file format. Excel 4.0 macro sheets or VBA macro code are stored (.xlm).






	

.xlsx



	

Strict Open XML Spreadsheet



	

A variant of an Excel Workbook file type that adheres to ISO standards (.xlsx).






	

.xlt



	

Excel 97-Excel 2003 Template



	

For an Excel template, the Excel 97 - Excel 2003 Binary file format is used.






	

.xltm



	

Excel Macro-Enabled Template



	

Latest Excel versions, Excel 2019, 2016, 2013, 2010, and 2007 macro-enabled file format for an Excel template. VBA macro code or Excel 4.0 macro sheets are stored (.xlm).






	

.xltx



	

Excel Template



	

For the latest Excel edition, Excel 2019, 2016, 2013, 2010, and 2007, the default file format for an Excel prototype is.xlsx. VBA macro code and Excel 4.0 macro sheets cannot be saved (.xlm).






	

.xlw



	

Excel 4.0 Workbook



	

Only chart sheets, worksheets, and macro sheets are saved in this Excel 4.0 file format. In the latest Excel versions and Excel 2019, 2016, and 2013, users can open a workbook in this file format but are unable to save it.






	

.xml



	

Spreadsheet 2003XML



	

XML is a file format for spreadsheets.






	

. XPS



	

XPS FOR Document



	

The XML Paper Specification is a file format that retains text formatting while still allowing for file sharing. The XPS file contains the same structure that users expected when accessed online or printed, and the details in the file cannot be readily modified.















 
Chapter 2: Microsoft Excel 2021




Excel 2021 (Excel 365) is the most recent version of the popular spreadsheet software, which has grown in popularity in recent years due to its flexibility. You can also deal in Excel without installing something. Microsoft also released two additional Office models for 2021: a business edition and an Office LTSC (Long-Term Servicing Channel) version for private clients. Office 2021 is eligible for Windows and macOS, and it's tailored for those who don't want to subscribe to Microsoft's cloud-based 365 packages.



Microsoft hasn't released a complete list of Office 2021's enhancements and updates yet, but the Office LTSC version includes dark mode support, accessibility improvements, and Excel features, including Dynamic Arrays and XLOOKUP.



2.1
 
 
 
Why Learn Excel 2021?




There is no doubt that Microsoft Excel 2021 has some new features, and the following are some of the features that distinguish it from previous Excel versions.



Automated Data Analyses With Excel Ideas



Excel Ideas is one of the latest Excel 2021 that supports data analysis and offers the necessary perspective for data analysis. Go to the Home tab of the Ribbon to find ideas in Excel. This functionality requires that you be actively linked to the internet.



XLOOKUP Instead of VLOOKUP



The XLOOKUP feature has replaced VLOOKUP. When you need to locate something in a table or range by row, you may use the XLOOKUP function. Unlike the VLOOKUP, which returns an appropriate match with what is being checked, the XLOOKUP returns an exact match. It also enables you to scan for data at any point during the data entry process. The XLOOKUP feature has the following syntax: = XLOOKUP (lookup value, lookup array, return array).







Dynamic Arrays



This is another Excel feature that allows you to compose a single formula that affects several cells simultaneously without copying the formula to each cell individually. Filter, sort, Sequence, sort by, Randarray, and Unique are all included in this feature.



2.2
 
 
 
Getting Started With Excel 2021




Excel is handy software, but it can also be confusing. That's why this book compiled all of the essential information to get started with Excel. It will walk you through the whole process, from opening a spreadsheet to entering and working with data for saving and sharing. To begin, make sure that Excel 365 is installed on your device.




How to Get Microsoft Excel Application?




You won't use Microsoft Excel unless you have the application installed on your device or access it by any source. There are several ways to get Microsoft Excel. You should get it from a computer hardware retailer that also offers software. Excel is software that is part of the Microsoft Office system suite. You can also download the license key by visiting the Microsoft website.




Buying and Installation of Office Software




Microsoft Office software includes many of Microsoft Corporation's essential software. When you purchase and install this app on your device, you can access various Microsoft products, including Excel. There are variations of Office available for buy on the office.com website and various online and offline retail outlets.



Before you launch Excel 2021 on your device, it's a good idea to know that the minimum Windows update that it will operate on is Windows 10. If you have a machine running Windows 7 or 8, you may need to update to Windows 10 before you can install it.



So, if you don't already have Office built on your phone, you should upgrade to the 365 update, which has many valuable features. There are a few places where you can purchase and update Office on your computer. For example, if you go to www.micrsoft.com, Microsoft suggests that you should buy the Microsoft 365 program for your computer.



This is because the app has several functional new enhancements applied to the package's modules. When you go to www.amazon.com, you will be guided to the website's homepage on the other side. Select software as your search choice from the drop-down at the top left-hand side of the site's search box. You can buy any office program you like from any computer device vendor shop near you. The seller can even begin the process of installing and activating the software package.




Getting Microsoft for Free

 



To try out Microsoft 2021(365), everybody will get a one-month free trial. You must enter a credit card because if you do not cancel until the end of the month, you will be charged $100 for a one-year subscription to Microsoft 365 Family (formerly called Office 365 Home).



If you don't need the entire package of Microsoft 365 applications, the good news is that you can get many of them for free online, like Word, Excel, PowerPoint, OneDrive, Outlook, Calendar, and Skype. Here's how to get your hands on them:



	
Visit Office.com.


	
Go to your Microsoft account and sign up (or create one for free). You do have a Microsoft account, whether you have a Windows, Skype, or Xbox login.


	
Choose the app you want to use and save your work to OneDrive in the cloud.






Signing In/Up to Office 365




You will conveniently log into Office 365 with your Microsoft account. Nevertheless, creating a new account is easy. Follow the instructions below to get started:



	
Go to https://login.microsoftonline.com to begin.


	
If you don't have an account, enter your email address and press "Next" or click "Create One" if you don't have one.




[image: ]



	
Enter your password and choose "Keep me signed in" to log in without having to type it in each time.


	
Now you're on the Office home page. You can conveniently choose the Office 365 package for 2021 to operate on this page. You can also select the "Install Office" button to download the entire Office 365 package to your computer, and then click the "Buy Office" button to subscribe. You can also use the free edition to get started.




[image: ]




How to Open Microsoft Excel?




The Navigation bar is located on the left side of the Office 365 home tab. You have the option of opening every app. To use Excel, go to the app launcher and select the excel icon. After that, you'll be taken to a new page where you can create a new workbook, open recent data, and use templates. To open a new page in Excel, click New blank workbook.


[image: ]



To access a previously worked workbook, choose a file from
 Recent
 . To access Excel documents on your computer, click
 upload
 and
 open
 . To select a template, click more
 templates
 . You should also be mindful that by default, the data are automatically saved to the Microsoft cloud. However, if necessary, you can download any file to your computer system.




Excel Start Screen




The Start Screen appears on the screen as you start the Excel application or click on Excel. The right panel and the left panel are separated on this screen. The left panel is green with the home icon selected, with New Open items at the top, an Account, Feedback, and options at the bottom. The right panel displays a chart of thumbnails with a variety of templates to choose from. The blank workbook, located on the right panel, is used to create a new blank Excel workbook file.




Customizing the Excel Workplace




The Microsoft Excel framework reflects how users use the MS Excel software or how they use an excel application. The components of Microsoft Excel are defined in the following sections. The Microsoft Excel GUI helps to improve the efficiency of MS Excel workbook processes and procedures.



The frame's formatting has improved thanks to the Live Preview functionality. Drag the mouse cursor over the instruction to see the format in the browser.



Users can modify the functioning GUI by using a few of the configurations mentioned below.



Making a Template in Excel



	
Open Microsoft Excel and create a fresh blank workbook.


	
Save the workbook in the required folder with a particular file name.





Additional advice and more specific steps are given below. A few Excel workbook fundamentals must be modified.



	
Font type and size:
 Highlight the areas of each worksheet you choose to modify, and then select your number, alignment, and font type options from the Font list at the top of the same worksheet.


	
Column size/layout:
 Typically, you choose various column widths, select the columns or even the whole sheet, and then adjust the column width.





Choose one or more worksheets in
 Print Settings,
 then go to Page Layout and then to Page Setting category to configure print settings such as headers and footers, page orientation and margins, and several other print layout options.



	
Gridlines:
 Would you choose darker gridlines for each worksheet? While the dark boundaries or grid lines may be seen, they do not print. To change the gridline color, go to File> Options > and then Advanced. Then choose Display choices for the current worksheet from the drop-down menu, and then select the workbook's title from the drop-down menu. Finally, under Display gridlines, choose a particular gridline color.


	
Worksheet count:
 You can add and subtract worksheets and rename sheet tabs and change their color.





Note:
 The actual layout and design of your customized default workbook will be restored when you add a new worksheet. To set aside an optional or main worksheet that you might copy if desired, you'll want to append extra worksheets to the actual workbook.



Setting the Color Theme



To customize the color theme for your Excel sheet, go to the Excel ribbon and click the FileOptions tab. To follow the steps below, the browser will open.



	
By contrast, the general tab on the left-hand side will be selected.


	
Under General choices for dealing in Excel, look for a color scheme.


	
Pick the appropriate color from the color scheme drop-down column. Select the OK tab.





Settings for Formulas



This option assists you in describing how Excel functions with formulas. You'll use it to make decisions, such as whether to use a complete automated layout, adjusting the cell reference style to use the column to row numbers and other options. If you want to start a function, select the checkbox. Delete the checkbox icon if you want to disable an option. This option is available from the Method tab's left-hand column's Options dialogue
 .



Proofing Settings



It manipulates the input text in Excel as an alternative. This allows options such as dictionary vocabulary, dictionary hints, and so on to be used when looking for incorrect spellings. This option can be found in the left-hand panel of the dialog box, under the check tab.









 
Chapter 3: Excel's Interface








Ribbons, groups, menus, and the spreadsheet itself make up the Excel interface. These features on the workbook are essential to work with on the blank page when you open a new blank workbook, and they are explained below:



3.1
 
 
 
The Title




This is mentioned at the very top of the interface. When you make a new file, it is automatically called Book 1, Book 2, Book 3, and so on. It's a good idea to rename the file to something you'll remember. Click the title at the top of the Excel interface to modify the file's name. Enter a new name for the file and choose where it should be stored in the Microsoft cloud (OneDrive).



3.2
 
 
 
Ribbon




Excel commands are accessed through the Ribbon. An order is a device procedure that is carried out. Build a new folder, print documentation, and so on are examples of commands. Instead of standard menus, the latest Excel edition 2021 employs a tabbed Ribbon scheme. The Ribbon has many tabs, each with a different set of commands. The Ribbon contains most of the Excel orders. They're organized in the form of tabs from the Home page to the bottom of the page.
 [image: ]



Let's go through each tab one by one, from left to right, to understand what they are for.



1.
 
 
File




This gives you a backstage view of all the essential file commands, such as creating a new sheet, opening a file, saving it, printing it, and exporting it.



2.
 
 
Home




This section contains the most important or commonly encountered Excel formatting, font type, and filtering commands.



Similar features are grouped, such as the Clipboard group, which includes cut, copy, paste commands, and the Font category, including font styles, colors, and sizes.



Notice that based on your screen size and the size of your Excel window (as you shrink it, fewer buttons appear), your ribbon choices will appear differently.



Since there are so many features, it has been split into two parts: to see all of the buttons and classes more clearly.


[image: The Excel ribbon - Home]
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3.
 
 
Insert




Users can add items like pictures, graphs, Pivot Tables, shapes, charts, and symbols to a spreadsheet.


[image: Excel ribbon - insert tab]


[image: Excel ribbon - insert tab]



4.
 
 
Page Layout




Users can change the margins, gridlines, color themes, and print area to configure the spreadsheet's style. The updates are often valid while printing.


[image: Excel ribbon - page layout]
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5.
 
 
Formulas




This is where all of the essential formulas are organized in the function library and where you can control them.


[image: Excel ribbon - formulas]
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6.
 
 
Data




This helps users organize data in the current spreadsheet and insert data from other sites within the file.


[image: Excel ribbon - data]
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7.
 
 
Review




Users may use this to control various functions, such as spell checking, translating, adding feedback and notes, tracking modifications, and enabling worksheet protection.


[image: The Excel ribbon - Review]



8.
 
 
View




Gridlines, freeze panes, zoom, and switch windows are among the options for changing worksheet views.


[image: Excel ribbon - view]
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9.
 
 
Help




This grants you access to Microsoft's customer support. It helps you to provide reviews and make a feature suggestion to the community.


[image: The Excel ribbon - Help]



3.3
 
 
 
How to Collapse and Restore the Ribbon in Excel




The Ribbon in Excel is a "fixed" feature by default, which means it remains in the same position as you scroll down the screen. When dealing with a vast range of data in Excel, you will want to increase screen size.



By collapsing the Ribbon, you can do it without zooming out or altering the font size of the content or text.



To collapse Ribbon in Excel



In Excel, you can collapse Ribbon by doing the following:



	
Click somewhere on the Ribbon with the right mouse button.


	
Select
 Collapse the Ribbon
 from the drop-down menu.





The Ribbon has now been hidden.



Excel's relevant ribbon will show if you select any of the required commands (Home, File, Page Layout, Insert, and so on).



To restore Ribbon in Excel



The Ribbon should be restored in the same manner that it was collapsed.



	
To open the Ribbon, click any command.


	
Unselect Collapse the Ribbon with a right-click somewhere.




[image: The Excel ribbon - Restore the Ribbon]



3.4
 
 
 
How to Customize the Ribbon in Excel?




Since the Excel ribbon contains the most often encountered commands, a personalized ribbon ensures a simpler and quicker Excel experience.



To customize the Ribbon in Excel, right-click somewhere on the Ribbon and pick Customize the Ribbon instead of collapsing it.



The window would appear, letting users personalize the Ribbon by removing or adding commands from current or new tabs.



To Add a Command to a New Tab



	
Select the New tab. Under the Main Tabs section, a new tab will be created.




[image: The Excel ribbon - Customize the Ribbon]









	
If you like, rename it by choosing Rename and then typing in a new name. In this case, "Go skills" is used:




[image: The Excel ribbon - Customize the Ribbon]









	
Tab OK.




[image: The Excel ribbon - Customize the Ribbon]









	
Add any command (for example, Insert Picture) under the Group.




[image: The Excel ribbon - Customize the Ribbon]









	
Under a group of the new tab (
 Go skills
 ), command (Insert Picture) shows.


	
To confirm the customization, click OK in the bottom right corner. To the right of the Home page, a new tab called Go Skills has been added. There's a group of one command—Insert Picture—under the tab.




[image: The Excel ribbon - New Tab]



Note:
 Users can also customize the Group's name. The procedure is the same as renaming the tab's name.



To Reset the Excel Ribbons



	
It is as necessary to reset and uninstall customizations as it is to customize them. To restore, go to Excel Options > Customizations > Reset All Customizations.


	
Tab Yes and OK are mentioned on the right bottom side.





Auto-Hide Ribbon and Show Tabs and Commands



There are shortcuts for displaying the Excel ribbons in the top left corner of the Excel window.


[image: The Excel ribbon]



	
To hide all tabs and commands, choose Auto-hide Ribbon.




[image: The Excel ribbon - Auto Hide]



	
Choose Show Tabs to see only Ribbon tabs.




[image: The Excel ribbon - Show Tabs]



	
Choose Show Tabs and Commands for a default view with all Ribbon tabs and commands on the screen.




[image: The Excel ribbon - Show Tabs and Ribbons]



Excel allows you to execute the most basic functions. The Excel Ribbon Interface features are divided into the following categories:



	
File menu button:
 When you first open this feature, you'll see Open, New, Save As, Export, Share, Publish, Account, Close, and other choices for changing Excel's default settings.


	
Quick access toolbar:
 Autosave, Undo, Save, and Redo are all available here.





	
Formula bar:
 This displays the cell's address as well as the contents of the cell.


	
Highlighted.


	
Worksheet area:
 This is where all of the cells being worked on are shown for everyone to see, with a column heading of letters and a row heading of numbers.


	
Status bar:
 This shows the program's current mode and lets you execute special operations on the worksheet.





Status Bar Modes



	
Ready mode.
 Nothing is being entered or modified in the spreadsheet at this time.


	
Enter mode.
 This mode is used for entering data and just typing in the contents.


	
Edit mode.
 Edit the current cell's contents. For this mode, double-click a cell with data or click within the formula bar.


	
Point mode.
 When using a formula or an Excel dialog window, the point mode links to cell addresses.


	
Clipboard:
 Windows has clipboard functions such as Cut, Copy, and Paste. A clipboard is a place where you can keep pictures and details for a short period. Just one object may be stored at a time in the Windows clipboard. The Multi Clipboard in Microsoft Office can hold up to 24 things, but the Paste button and shortcuts for the Paste option only apply to the most recently copied item. To use this tool, you must have the clipboard pane opened.


	
Cut:
 The selection is copied to the clipboard. The choice will vanish if it is text or a photograph. If it's a cell, Excel won't erase the original unless you paste it.


	
Copy:
 The selection is copied to the clipboard.


	
Paste:
 Retrieves the most recently copied text or object from the clipboard.





3.5
 
 
 
Understanding the Workbook




Any procedure in the Excel program is performed directly on the workbook. The workbook stores data such as letters, numbers, and formulas, and inside the workbook is the worksheet. A worksheet in a workbook has 16,384 columns labeled with letters of the alphabet and 1,048,576 columns labeled with the numbers 1 to 1,048,576.



Creating a New Worksheet



To display the
 Excel start
 , open your Excel software and select New.



Renaming a Worksheet



Sheet 1 is the default name for a new Excel workbook when you launch it. However, you can adjust the name to anything you want by right-clicking on the worksheet you want to rename. Select the Rename option, type in the new name you want to use, and then press Enter.



Inserting a New Worksheet



Beside the worksheet, click the + button. The new sheet has been added.



Deleting a Worksheet



Right-click on the worksheet you want to delete and choose Delete. If you want to remove it, the worksheet would be removed from the workbook.



Copying or Moving on Worksheet



Right-click on the worksheet to move or copy and choose Move or Copy from the drop-down menu. The location where to copy it will be updated if you select the Copy or Move option. If you choose to move the worksheet and not copy it, all you have to do is drag it to the desired location.



Changing the Worksheet



To change the color of a worksheet, right-click on it. Find the color you want by clicking on Tab color and pressing enter.



Saving Document



When you've finished working on a workbook, you have two options for saving it in Excel. When you edit/update a workbook that has already been saved on your device, you use the Save option. This choice helps you to save your Document's latest updates. When you make a new file, the Save As feature is used. You must name it and position it. This command may also be used to create a copy of a text, but you must assign it a different name and position to prevent overwriting the old, copied edition.



Recover Document Using Autosave



If you've lost a document and aren't sure how to retrieve it, the Excel software has features that help you recover any missing document. To do so, open Excel and press on the recovered version of the text you want on the left-hand side of your workbook. Your Excel documents are automatically saved after 10 minutes, but if your computer crashes before that point, the paper will be lost entirely. If you sign in to Excel with your Microsoft account, you can save your Document to OneDrive.



Exporting Workbooks



Excel workbooks are saved in the.xlsx file format by default. However, there are times that you may need to use a specific file type or a lower edition of the Excel program. To do so, go to the backstage view of the Excel program and choose Export. Then select Create Pdf/XPS Document from the drop-down menu.



Select Change File type if you want to make a change.



Sharing Excel Workbook



In the top right corner of the Excel worksheet, select the Share option. Go to OneDrive and upload your file. You will send an invitation link to your contacts to access or update the documents after it's been uploaded. You can share files by submitting them as an attachment or by providing a link to the file.



3.6
 
 
 
Understanding the Cell




The details on the worksheet are inserted into the cell. Thousands of rectangles identified as cells can be seen on the worksheet. The intersection of a row and a column is the cell. They are the worksheet's fundamental building blocks. As previously stated, each cell on the worksheet has its name or cell address, which is shown in the top left corner of the worksheet. A cell range is a collection of cells; a cell range is a collection of more than two cells, and it is written in the following format: A1:A5 or B1:B5. To choose a cell set, hold down the mouse button and move it to the cells you want to highlight. Release the mouse and select the cell set you like.



Inserting Contents in the Cell



Select the cell into which you want to type. Enter the text into the cells, and the



content would show in the cell and the formula bar. If you want to remove the contents of a cell, choose it. Backspace or press Delete.



Delete a Cell



Click the cell you want to remove or delete from the worksheet, then click the Delete command on the Ribbon Home tab and choose the appropriate choice. Following this step, the cell can shift up on its own.



Copy and Pasting Cell Content



Choose the data you want to copy from a cell. On the Home page, choose Copy, select the place where you want to paste it, and click Paste from Home.



Dragging and Dropping the Cell



Drag and drop may also be used to move data from one cell to another. Choose the cells you'd like to move. To move the content of the cells you've selected, move the cursor over the boundaries of the cells you've chosen and drop them. Drag the cells to the target position by clicking, holding, and dragging them. When you let go of the mouse, the cells would shift to the required location.



Fill Handle in the Cell



Fill Handle in Excel relieves the pain of transferring data from one cell to another in a worksheet. You can easily copy and paste the contents of a cell to neighboring cells in the same row or column using the fill handle. To use the Fill Handle, choose the cell whose content you want to copy, and the fill handle emerges as a small square in the cell's bottom right corner. Click, hold, and drag the fill handle to duplicate any of the cells you choose to fill. Then let go of the mouse to fill the cells you've chosen. The fill handle may be used to continue a sequence of numbers (1, 2, 3) or days. Most of the time, you'll need to pick several cells before this fill handle can function.



3.7
 
 
 
Formatting the Cell




On the Home tab, you'll find the most formatting choices. The Format Cells window contains all of the options. This has several tabs that will assist us in formatting the contents of our spreadsheet. The More Options button at the end of the Format, Alignment, and Number groups will open this window. You could also use the Ctrl+1 keyboard shortcut or the right-click shortcut menu to choose Format Cells.



Font



Font: Sets the font of the chosen cell (s). Fonts are several means of displaying the same letters.



	
Font size:
 Controls the letter size (the font). Fonts are larger when the numbers are high.





	
Increase font size: Increases the font size.


	
Decrease font size: Reduces the font size.





	
Bold:
 Makes the cell(s) chosen bold.


	
Italic:
 Italicizes the chosen cell(s).


	
Underline:
 Highlights the chosen cell(s). There is a double underline on the drop-down menu.


	
Borders:
 For the chosen cell, adds and eliminates borders (s). More Borders can be included in the drop-down menu.


	
Fill color:
 Changes the color of the chosen cell's background (s).


	
Font color:
 Modifies the font color of the chosen cell (s).


	
More options:
 Clicking this button brings up the Format Cells dialogue box.





Alignment



	
Top align:
 Aligns the cell vertically at the top.


	
Middle align:
 Aligns the cell vertically in the center.


	
Bottom align:
 Aligns the cell vertically to the bottom.


	
Orientation:
 Rotates the cell's contents to the currently selected option.


	
Wrap text:
 Displays the cell's contents on multiple lines inside the column width of the cell.


	
Align text left:
 Aligns the contents of the column horizontally on the left line.


	
Center:
 Aligns the contents horizontally to the cell's center.


	
Align text right:
 Aligns the contents of the cell horizontally on the right hand.


	
Decrease indent:
 Reduces the amount of space between the text and the cell boundary.


	

 Increase indent:
 Increases space between the text and the cell boundary by increasing the indent.


	

 Merge and center:
 Combines adjacent cells into a single cell and centers the result. Excel can only hold the data from the upper-left cell if there is data in more than one cell.


	

 More options:
 This button will take you to the Alignment tab of the Format Cells dialogue pane.





Number



	
Number format:
 Changes how integer numbers will be represented on a spreadsheet. A drop-down arrow displays the selection of the most popular formats and an alternative for Further Number Formats.


	
Currency type:
 Sets the Currency Style for the chosen cell(s). This style retains the dollar signs on the left side of the cell and the amount on the right. Other currency formats, such as the Euro (€), are available using the drop-down button.


	
Percent type:
 This style consists of zero decimal positions and is applied to the chosen cell(s).


	
Keyboard shortcut:
 Press Ctrl +Shift+%. Cell Styles on the Home Tab may be used to reset this switch.


	
Comma style:
 This style has a comma for every thousand and two decimal points, and it is applied to the chosen cell(s). This icon may be reset by pressing the reset button.


	
Increase decimal:
 This option increases the number of decimal positions that appear to the right of the decimal.


	
Decrease decimal:
 Reduces the number of decimal positions shown to the right of a decimal.


	
More options:
 This button will take you to the Number Tab of the Format Cells dialogue box.





Cell Size (Column Width/Row Height)



You can't resize a single cell since its arrangement is determined by the whole row and column on which it is located. The Column Width and Row Height options are located in the Cells group of the Home tab's Format menu.



Adjusting With the Mouse



When you resize, you'll notice that you're moving away from the left. Place the pointer between the lines of the column heading to resize the column. The new column heading is located inside a box; you have to enlarge the box. Before resizing,an arrow heading in two directions emerges, move the cursor across the right side of the heading window. Select away from the letter in the column. The column will resize as you release the button. Place your mouse cursor between the lines of the row headings to resize the row. The current row heading is contained inside a frame; what you have to do now is enlarge the box. Drag the mouse away from row number until you see the resizing arrow pointed in two directions. The row will resize as you release the button.



Aut
 o‐
 Fitting



You can use the Format menu option or position the mouse cursor between headings and double-click with the two-way headed arrow to resize it. Inside its structure, the row or column can AutoFit to the maximum data length. To resize several cells simultaneously, choose the cells you want to fit and repeat the steps above. If you're using DoubleClick to autofit, you'll need to select the whole column/row structure.



Inserting, Deleting, Moving, and Hiding Rows and Columns



You can choose whether to introduce new columns or rows, remove those rows or columns, transfer them to a different position in the worksheet, and even hide them after working on a workbook for a while.



To Insert Rows



	
Click the row heading below the one you want to add a new row to.


	
On the Home page, choose the Insert command.


	
The chosen row will be replaced by the new row.





Note:
 The Insert Options button would appear next to the inserted cells while adding new rows, columns, or cells. This button helps you to customize the formatting of these cells in Excel. Excel formats added rows by default to match the formatting of the cells in the row above. Hover the cursor over the Insert Options button, then press the drop-down arrow to unlock further options.



To Insert Columns



	
To add a new column, choose the column moving to the right of where you expect it to start.


	
On the Home page, choose the Insert command.


	
To the left of the chosen column, the new column would appear.





Note:
 When adding rows and columns, make sure you press the heading to pick the whole row or column. The Insert command can only insert a new cell if you select only one cell in a row or column.



To Delete Rows



It's simple to delete a row in your workbook that you don't use.



	
Choose the row(s) you have to exclude from the list.


	
On the Home page, choose the Delete command.


	
The chosen row(s) will be removed, and the rows below them will be moved up.





To Delete Columns



	
Choose the column(s) you want to exclude from the list.


	
On the Home page, choose the Delete command.


	
On the Home page, choose the Delete command. 3. The chosen column(s) will be removed, and the columns to the right will be moved to the left.





Note:
 Understanding the difference between removing a row or column and merely clearing its contents is critical. Right-click a heading, then pick Clear Contents from the drop-down menu to delete the output of a row or column without allowing others to change.



To Move a Row or Column



You may want to rearrange the content of your worksheet by moving a column or row.



	
Press the Cut command on the Home tab or hold Ctrl+X on the keyboard to choose the desired column heading for the column you want to move.


	
To the right of where you intend to move the column, choose the column heading. Select column C, for example, if you decide to shift a column between columns B and C.


	
On the Home page, click the Insert command, then pick Insert Cut Cells from the drop-down display.





	
The column will be shifted to the desired position, and the columns to the right will migrate to the right as well.
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Note:
 The Cut and Insert commands can also be accessed by right-clicking the mouse and choosing the appropriate commands from the drop-down list.



Hide and Unhide a Row or Column



You may want to compare specific rows or columns without altering the design of your worksheet at times. You can hide rows and columns in Excel as desired.



	
Right-click the mouse on the column(s) you want to hide, then choose Hide from the formatting menu.


	
The columns would be hidden. The hidden columns are shown or will be indicated by the green column line.


	
Click the columns to the left and right of the hidden columns to reveal them (in other words, the columns on both sides of the hidden columns).


	
Choose Unhide from the formatting menu by right-clicking the mouse. The columns that were formerly hidden will reappear.





Wrapping Text and Merging Cells



When there is so much cell content to accommodate in a single cell, you can wrap the text or combine the cell rather than resizing a section. Wrapping text changes, the row height of a cell, enabling cell contents to be viewed on several lines. Merging cells helps you to make one large cell by combining adjacent, empty cells.



	
Choose the cells you'd like to wrap.


	
On the Home page, choose the Wrap Text command.


	
The chosen cells' text would be wrapped.
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To Access More Merge Options



On the Home page, click the drop-down arrow next to the Merge & Center command. A drop-down menu for Merge will appear. You can do all of the following things from here:
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Merge & center:
 Combines the contents of several cells into a single cell and centers the text.


	
Merge across:
 Combines selected cells into wider cells while retaining row separation.


	
Merge cells:
 Combines the contents of several cells into a single cell but does not center the text.


	
Unmerge cells:
 Separates the contents of selected cells.











 
Chapter 4: Cell Referencing in Excel








A cell reference is an alphanumeric attribute or data used to find or describe a cell in a worksheet. The cell reference for the column contains one or more characters, and the cell reference for the rows includes a number (A1). A cell reference refers to a cell or a series of cells on a worksheet that can be used in a calculation to tell Microsoft Office Excel where to search for the values or details that the formula can calculate.
 Cell Address
 is another term for cell referring.



Relative and absolute cell references are the two kinds of cell references. When you copy and filled the formula into other cells, absolute, and relative references act differently. Whenever you copy the formula to another cell, the relative references change. Absolute references do not change regardless of when they are copied.



4.1
 
 
 
Relative Cell References




All thecell references are relative references by default. They adjust depending on the relative location of columns and rows when copied through many cells. The formula becomes =A2+B2 when you copy it=A1+B1 from row 1 to row 2. If you need to replicate the same equation through several rows or columns, relative references come in handy.



Using Relative References to Generate and Copy a Formula



If you want to make a formula that multiplies each item's price by the quantity, it's illustrated in the following example. You can make only one formula in cell D2 and copy it to the other rows instead of making a different formula for each row. You must use relative references for the formula to calculate the total for each item correctly.



1. Choose the cell where the formula would be inserted. Select cell D2 for this example.



2. To calculate the total quantity, enter the formula. Type =B2*C2 in the example below.
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3. On the keyboard, press Enter. The formula would be applied, and the output will show up in the cell.



4. Find the fill handle within desired cell's lower-right corner. You must find the fill handle for the D2 cell in this example.



	
Move the fill handle over the cells you want to fill by clicking, holding, and dragging it.


	
Let go of the mouse. The formula will be copied with relative references to the chosen cells, and the values will be determined in each one.





Note:
 To double-check for the formula’s accuracy in the filled cells, double-click them. Depending on the rows, each cell's relative cell references should be different.



4.2
 
 
 
Absolute Cell References




When filling cells, there are times when you don't need a cell reference to change. Absolute references, unlike relative references, do not alter when copied or filled in. To hold a row and column constant, use an absolute reference. The introduction of a dollar sign ($) to a formula designates an absolute reference. It may come before the column or row reference, or both.



When creating formulas with absolute references, you'll usually use the $A$2 format. The other two formats are much less often used.



Note:
 To shift between relative and absolute cell references when writing a formula, click the F4 key on your keyboard. This is a short and simple way to incorporate an absolute reference.



Using Absolute References to Copy and Generate a Formula



Using the sales tax rate of 7.5 percent in cell E1 to determine the sales tax on all goods in column D in the following example. In this case, the $E$1 absolute cell reference will be required in the formula. Since each formula uses the same tax rate, the reference would stay the same when the formula is copied and pasted onto other cells in column D.



	
Choose the cell where the formula would be inserted. In this case, choose cell D3.


	
To evaluate the desired value, enter the formula. Type =(B3*C3) *$E$1 for this case.


	
On the keyboard, press Enter. The formula will function, and the product will emerge in the cell.


	
Locate a fill handle within the required cell's lower-right corner.


	
Releasethe mouse. The formula would be copied with an absolute reference to the selected cells, and the values will be determined in each cell.





4.3
 
 
 
In Excel, How to Refer to Another Sheet?




Add the worksheet's name preceded through an exclamation mark (!) just before cell address to refer to a cell or range of cells in another worksheet in the same workbook. To put it another way, you can use the following format in an Excel reference to another worksheet:



	
An individual cell is referred to as
 Sheet_name
 !
 Cell_address
 t
 o refer to Sheet2 cell A1, for instance, Sheet2!A1 is typed.


	
The range of cells is referred to as
 Sheet_name
 !
 First_cell
 :
 Last_cell
 t
 o refer to A1:A10 cells in Sheet 2, for instance, Sheet2! A1:A10 is typed.





You must enclose the name of a worksheet in single quotation marks, whether it contains spaces and non-alphabetic characters. E.g., in a worksheet called Project Milestones, an external reference to cell A1 can be read as: “Project Milestones”! A1.



The Excel sheet reference seems like this in a real-life formula that multiplies the value in cell A1 in the “Project Milestones” sheet by 10:=“Project Milestones”! A1*A10.



Creating a Reference to Another Sheet in the Same Workbook Automatically



Simply pointing Excel to the cell/range you want to establish the reference and letting Excel create this for you is a much simpler way to make a cell reference to another sheet.



You won't have to think about the exclamation point, quotations, or any other formatting issues arising as a result of this. Excel can generate the appropriate reference for you.



The directions to automatically construct a reference to another sheet are as follows:



	
In the current workbook, choose the cell where the reference is required.


	
Start typing the formula before you use it as a reference (or an equal-to sign if you want the reference)


	
Choose the sheet you'll be referring to.


	
Choose the cell/range to which you want to refer.


	
Press Enter to see the formula's result (or continue working on the formula)





The steps above would create an automated reference to the cell/range in another sheet. These references would also be noticeable in the formula bar. When you're done, press the enter key to get the result.



For example, if you have data in cells A1:A10 of a sheet called Sales Data and want to get the total of these values in the current sheet, you can do so by performing the following steps:



	
In the current sheet (at which you need the result), type the following formula: =Sum(




[image: Enter the formula to the point where you need the reference]



	
Select the “Sales Data” sheet.


	
Choose the range you want to include (A1:A10). Excel can immediately generate a reference to this range as soon as you do this (you can notice that in the formula bar).


	
Press the enter key.





You will have to refer to a cell or a range in another sheet when creating a long formula, and then you may need to return to the origin sheet and refer to a cell or range there. Excel will automatically insert a sheet reference to the sheet where the formula is located when you do this. While this is acceptable and does not cause harm, it is not needed. In this case, you have the option of keeping the reference or manually removing it. Another factor to keep in mind when making references by choosing the sheet and then the cell/range is that Excel can often generate a relative reference (i.e., references that start with n0 $). This implies that if You copy and paste the formula (which has a reference to another sheet) into another cell, the reference will be automatically adjusted.



4.4
 
 
 
In Excel, How to Refer to Another Workbook?




The format of a reference to a cell or a range in another Excel workbook is determined by whether the workbook is opened or closed. The format is affected by the workbook title and worksheets (based on whether the name contains spaced or non-alphabetic characters)



External Reference to an Open Workbook



You should define the worksheet name, the workbook name, and the cell/range address when referring to an external open workbook. When referring to an external open workbook, follow the format outlined below.



=“[FileName]SheetName! CellAddress



Let’s say you have a workbook called "ExampleFile.xlsx," and you want to refer to cell A1 on Sheet 1 of this workbook.



The following is a reference to this:



=[ExampleFile.xlsx]SalesData!A1



You must have to add the name of the file (in square brackets) and the name of the sheet if the external workbook or sheet name (or both) includes spaces (in single quotes)



How to Create Reference to Another Workbook (Automatically)



Although knowing the format is helpful, it's better not to type it by hand or manually.



Instead, point Excel in the right direction, and it will automatically generate these references. This is a lot smoother, and there are far fewer chances of making a mistake.



For example, if you have data in cells A1:A10 in the sheet “Sales Data” in a workbook called “Example File,” and you want to get the number of these values in the current sheet, the steps are as follows:



	
In the current sheet (where you need the result), type the following formula: =Sum(


	
Open the workbook titled "Example File."


	
Go to the “Sales Data” sheet and select it.


	
Choose a range you want to include (A1:A10). Excel will automatically generate a reference to this range as soon as you do this (you can see that in the formula bar)


	
Press the enter key.





This will create the formula with the proper references instantly.



When you create a reference to an external workbook, you'll find that it still generates absolute references. This indicates that a $ symbol precedes the row and column numbers. Because of the absolute reference, if you copy and paste this formula into other cells, it will still correspond to the same range.



If you want to change this, you'll have to manually adjust the references.



External Reference to a Closed Workbook



You need to indicate the file name, sheet name, and cell/range address when an external workbook is open, and you refer to it.



When you close this, Excel does not indicate searching for the cells or range you mentioned.



This is why you must also define the file path when creating a reference to a closed workbook.



The following is a reference to the A1 cell in the worksheet Sheet1 of the Example File workbook. As this file isn't open, it often refers to the file's save location.



='C:\Users\sumit\Desktop\[Example File.xlsx]Sheet1'!$A$1



The following sections are included in the above reference:



	
File path
 : The address of the external file on your device or system


	
File name
 : The name of the external workbook This will also apply to the file extension.


	
Sheet name:
 The name of the sheet in which the cells/ranges are located.


	
Cell/Range address:
 The exact cell/range address you're talking about.





You'll notice that when you make an external reference to an open workbook and then close the workbook, the reference changes immediately. Excel automatically adds a reference to the file path after the external workbook is closed.







 
Chapter 5: Dynamic Array, Variables, and Macros in Excel








The new dynamic array function in Excel is one of Microsoft's most valuable additions in years. With dynamic arrays, you can now create formulas that are more powerful than ever before. Dynamic arrays, in other words, allow one to break away from the typical “one-cell and one-formula" model. Instead, people will now use a single formula to locate results across multiple cells. Microsoft has since introduced several additional functions that return outcomes in these dynamic arrays.



5.1
 
 
 
Understanding the Concept of a Dynamic Array




The "one-cell, one-formula" paradigm in the previous paragraph is discussed. You have to type formulas into any cell where you needed calculation outcomes to appear. You can use Dynamic arrays, which will modify this by encouraging one to construct a single formula whose results can occur in as many cells as possible, depending on the amount of data being considered. The formula shown in the formula bar in the illustration below was only entered into cell D2 in this case. On the other hand, the formula dynamically copied itself to construct a table of all the range's specific values.



The concept of a "dynamic array" is shown in the simple illustration above. It demonstrates that dynamic arrays will fill several "results" cells even though the formula is only entered into a single cell. Importantly, if the source set in the example (B2:B8) had first been converted to a table, the number of results in the dynamic array would change as the volume of data in the Table changed.



5.2
 
 
 
New Functions to Capitalize on Dynamic Arrays




FILTER



The FILTER function, as its name suggests, may be used to filter data in a table or range using a formula. The syntax is simple, as shown here.





	

=FILTER(array (Table or range), include (a Boolean array for which items to include))









RANDARRAY



The RANDARRAY function generates a random number array. The RANDARRAY syntax is as follows.





	


=RANDARRAY([rows],[columns],[min],[max],[whole_number])
 ,










Where:



	
The row
 is an argument that tells how many rows can be returned.


	
The column
 is an argument that tells how many columns can be returned.


	
Min
 is an argument that tells the smallest valuethat should be returned,


	
Max
 is an argument that specifies the maximum number that should be returned, and


	
The whole number
 is an argument that tells Excel to return TRUE if the number is a whole number and FALSE if the number is a decimal.





SEQUENCE



The SEQUENCE function may be used to create a list of sequential numbers that are shown in an array. The SEQUENCE function has a simple syntax, as seen below.





	

=SEQUENCE(rows, [columns], [start], [step]),









SORT



SORT allows you to sort a table or data set depending on the values in a single column. The SORT function's syntax is as follows.





	


=SORT(array (table or range), Sort index (column), Sort_order (1 for ascending, -1 for descending))










SORTBY



The SORTBY function in Excel sorts an array or range depending on the values in another array or range. The following is the SORTBY syntax.





	

=SORTBY(array, by_array1, [sort_order1], [by_array2, sort_order2],…)
 ,









Where:



	
The array
 is a necessary argument for sorting an array or a range.


	
By_array1..2..3..etc.
 is the range or array to sort on,


	
Sort_order1..2..3..etc.
 is the sorting order, with-1 being descending and 1 being ascending (default)





UNIQUE



This function finds all unique values in thelist or range and returns a list of them. The UNIQUE syntax is as follows.





	

=UNIQUE(array,[by_col],[exactly_once])
 ,









Where:



	
The array
 is an essential argument for returning the unique columns or rows,


	
By_col
 is an argument that specifies how to compare. A TRUE entry compares columns to each other and returns the specific columns, while a FALSE (or omitted) entry compares rows to each other and returns the unique rows


	
Exactly_once
 is a logical argument that can be used to return columns or rows that appear only once in the set or array. FALSE returns all distinct columns or rows from the range or array, while TRUE returns all distinct rows or columns that appear only once.





5.3
 
 
 
VBA Variables in Excel




Variables are found in nearly any computer program, like VBA. Declaring a variable at the start of the procedure is a good idea. It is not essential, but it aids in determining the content's nature (data, text, numbers, etc.)



Variables are unique values saved in a computer's memory or storage device. You can then use the value in the code and run it. The value will be retrieved from the system and shown in the output by the computer. A name must be assigned to each of the Excel VBA variable forms.



The following rules must be followed when naming a variable in VBA.



	
It must be fewer than 255 characters long and have no spaces.


	
It should notstart with a number.


	
A period isn't allowed.





Variables may be declared either implicitly or explicitly in VBA.



Variables in VBA are similar to variables in other programming languages. The keyword "Dim" is used to declare a variable in VBA.



The Syntax for VBA Variable



In VBA, type Dim preceded by a name to declare a variable:



Sub Exercise ()



Dim <name>



End Sub



You must first record a macro in Excel before executing the variables. To recorda macro, perform the following steps:



	
Record Macro 1


	
Stop the Macro 1


	
OpenMacro editor and type the variable code in Macro1.


	
Run the Macro 1 code.





5.4
 
 
 
What Are Macros in Excel?




A macro is nothing more than a set of instructions. Excel can step-by-step perform your macro instructions on any data you give it after you've built it.



E.g., a macro might instruct Excel to consider a number, add in two, multiply it by five, and return that modulus.



Now, if you say Excel to run the macro, you don't have to do each step manually; Excel will take chargeof it.



It does not seem to be a big deal at first, but macros will save you a lot of time if you repeat the same steps frequently.



Filtering, Formatting raw data, and sorting data, or adding the same set of functions and operations to the sheets are all possibilities.



They're even helpful for networking since macros can be saved in Excel spreadsheets, so you don't have to email extra files to your coworkers. Write a macro, give the spreadsheet to them, and let them operate on it.



If you deal with spreadsheets daily, macros will save you a significant amount of time.


How to Record a Macro in Excel?



You'll need to "record" a macro before you can begin automating the Excel actions with macros.



When you record a macro, you instruct Excel which steps to follow when you run it.



Although Visual Basic for Applications (VBA) can be used to code a macro, Excel also allows you to record a macro using standard commands.



How to Run a Macro in Excel?



You can use the macro in a variety of ways once you've saved it.



You can start by running it from the Ribbon. A button called Macros can be found both on the View and Developer tabs. To see your macros, click the icon.



You can choose and run any macro you've saved from the resulting window. Click it and press the Run button.



Excel will recreate the steps from the recording session.



You may also use a shortcut key to operate your macro if you designated one when you saved it. To save, hold down Ctrl and the key you typed into the save window.







 
Chapter 6: Data Manipulation








Microsoft Excel is among the most widely used data processing and manipulation software. It can be challenging to correlate details in your workbook while dealing with a lot of data. With its built-in pivot tables, Excel is undoubtedly the most common analytic method in the marketplace. It's a one-stop data management solution that lets you import, explore, organize, analyses, and visualize your data with ease. The tools listed below are relatively simple, but they can be beneficial when processing data.



6.1
 
 
 
Freezing Panes and View Options




Excel includes several tools, such as the option to freeze panes and split the worksheet, making it easier to display content from different sections of the workbook at the same time.



To Freeze Rows



You will want to keep some rows or columns in your worksheet visible all of the time, especially header cells. You can scroll through the content while only seeing the frozen cells by freezing rows or columns in place.



Select the row under the row(s) you want to freeze.



	
On the Ribbon, select the View tab.


	
Select Freeze Panes from the dropdown menu after selecting the Freeze Panes command.





As shown by the grey line, the rows would be frozen in place. You will continue to see the frozen rows at the top while scrolling down the worksheet.



To Freeze Columns



	
Click on the column to the right of the one or more columns you choose to freeze.


	
On the Ribbon, choose the View button.


	
Select Freeze Panes from the dropdown menu after selecting the Freeze Panes command.


	
As shown by the grey line, the column would be fixed in place. You will continue to view the frozen column on the left while scrolling through the worksheet.





Click on the Freeze Panes command, then choose Unfreeze Panes from the dropdown menu to unfreeze rows or columns.



To Split a Worksheet



You may want to compare various parts of the same workbook without having to create a new window. The Split command divides the worksheet into several panes that each scroll independently.



	
Choose the cell where you want the worksheet to be split.


	
Select the Split command from the View tab on the Ribbon.


	
The workbook would be divided into several panes. The scroll bars enable you to compare various parts of the workbook by scrolling across each pane separately.





To undo the split, tap the Split command once again.



6.2
 
 
 
Sorting Data




As you add more detail to a worksheet, it becomes increasingly important to organize it. Sorting the data will help you easily reorganize a worksheet. A collection of contact addresses, for example, may be arranged by the last name. Sorting content numerically, alphabetically, and in a variety of other forms is possible. When sorting files, you must first decide if the sort should be applied to the whole worksheet or only a cell range.



	
Sort sheet organizes all of the information in the worksheet into one column.


	
Sort range organizes the data in a range of cells, which is useful when dealing with several tables on a board. Other data on the worksheet would not be affected by sorting a range.





To Sort a Sheet



For this example, Alphabetically, a T-shirt order type is sorted by Last Name (column C).



	
Choose a cell in the column that you want to sort through. In this case, choose cell C2.


	
Press the Ascending option to sort A to Z or the Descending option to sort Z to A on the Ribbon Data tab. Here Ascending command is used as an example.


	
The chosen column would be used to sort the worksheet. The last name has sorted the worksheet in this case.





6.3
 
 
 
Filtering Data




It can be challenging to locate details quickly if the worksheet has a lot of content. Filters can use to narrow down the details in your worksheet so that you can see what you need.



To Filter Data



	
The worksheet should have a header row that identifies the name of each column for filtering to work correctly.


	
Select the Filter command after selecting the Data tab.


	
With each column, a dropdown arrow would display in the header cell.


	
Choose the column you want to filter by using the dropdown arrow.


	
You'll see the Filter menu appear.


	
To easily deselect all data, uncheck the box next to Select All.


	
Choose the data you want to sort by checking the boxes next to it, then click OK.





Select the Filter command on a Data tab to remove all filters on your worksheet.



6.4
 
 
 
Find and Replace




When dealing with a massive proportion of data in Excel, finding specific information can be challenging and time-consuming. You can use the Find feature to quickly browse your workbook, and you can also use the Replace feature to change the content.



To Find Content



	
Click the Find and Choose command on the Home page, then pick Find. from the dropdown list.


	
The dialogue box for Find and Replace will appear. Enter the content you're looking for.


	
Choose Next from the Find menu. If the data is found, the cell that contains it would be selected.


	
Select
 Find Next
 to find more instances of the search term or
 Find all
 to display all instances of the search term.


	
To close the Find and Replace dialogue box, select Close when you're done.





Note:
 You can also use your keyboard to access the Find command by pressing Ctrl+F.



Note:
 In the Find and Replace dialogue box, click Options to display advanced search criteria.



To Replace Cell Content



You might find that you've made an error repeatedly in your workbook (for example, misspelling someone's name), either that you need to substitute a term or expression for another. To make swift changes, use Excel's Find and Replace feature.



	
Select Replace from the dropdown menu after clicking the Find and Choose command on the Home page.


	
A dialogue box called Find and Replace will open. In the Find what: field, type the text you're looking for.


	
In the Replace with the field, type the text you want to replace it with, then select Next.


	
If the content is detected, the cell holding it is chosen.


	
Double-check if you want to replace the text.


	
Choose one of the replace choices if you want to replace it:





	
Replace would replace individual instances
 .


	
Replace every instance of the text in the workbook by
 Replace All.





	
A dialogue box will open, confirming the number of replacements that have been performed. To proceed, click OK.


	
To close the Find and Replace dialogue window, press Close when you're done.





6.5
 
 
 
Data Validation




Excel's data validation feature allows you to limit the types of data or values that users will enter in a cell. To be more specific, you should set up "validation" rules on cells to determine what kind of data the cell can accept.



Data Validation Dialogue Box



It's easy to use this feature. Select the cell(s) and click ‘Data” from the tab list to create and apply a validation rule.



Then, in the “Data” tab, choose “Data Validation” from the “Data Tools” group



The data validation window will open right away.



There are seven (7) different categories of data that you can set:



	
List


	
Decimal


	
Time


	
Date


	
Whole number


	
Custom


	
Text length





You can choose from a variety of criteria depending on the data you've chosen:



	
not between


	
between


	
not equal to


	
equal to


	
less than


	
greater than


	
less than or equal to


	
greater than or equal to





Once you've chosen a criterion, you'll be provided with additional options to fill out:



	
not between


	
between


	
not equal to


	
equal to


	
less than


	
greater than


	
less than or equal to


	
greater than or similar to





The user will get a warning close to the one below if the entry ignores the validation rule:


[image: ]



How to Allow Whole Numbers and Decimals Only



	
Only whole numbers and decimals are permitted:


	
Choose the cell(s) on which the rule would be applied.


	
Open the dialogue box for data validation.


	
Under “Allow,” choose any data type.


	
Under data, set the criteria.


	
Include any additional information that is needed.





Example:



A list of employees with ID numbers ranging from 100000 to 999999.



How to Create Dropdowns



To make a data validation Excel list, follow these steps:



	
Open the data validation dialogue box by selecting the cell(s) to which the dropdown should be added.


	
Select “List” under “Allow”


	
Check the “In-cell dropdown” checkbox.


	
Eventually, include the “Source” details.





You can use the source in one of two ways:



	
Usecell reference.


	
On the text input, write the options.





Example:



In an employee list, deciding which department an employee belongs in is a difficult task.



Assume you have three departments:



	
Production


	
Admin


	
Sales





You can explicitly write them on the text input differentiated by a comma while selecting the “Source” for the dropdown's collection (,).



When you click “OK,” the dropdown menu would appear in the cells.



Fortunately, a data validation list may be generated from a table or a range of cells.



List the categories or options on the same worksheet or another, as long as you're in the workbook.



Refer to the cells with the dropdown list's categories or options in the “Source” option. When you're done, click “OK.”



How to Validate Dates and Time



It's simple to accomplish the validation dates and times. The criteria, on the other hand, can be avoided.



To validate dates and times, do the following:



	
Open the data validation dialog window. Select “Date” or “Time” under “Allow” to apply the validation to the selected cell(s).


	
Choose the most suitable criterion (there are lots of them; choose the best that meets your needs)


	
Include any additional details needed (preferably, write the dates in the worksheet and refer to them like in the example)





Example:



In an employee timesheet, the user should only enter dates that fall during the existing or designated week (September 2–8, 2019).



How to Create Text Length-Based Rule



You can also make a rule that the cell can only allow texts that are less than a certain number of characters long.



Follow these steps:



•
 
 Choose the cell(s) on which the rule would be applied.



•
 
 Choose “Text length” under “Allow” in the data validation dialogue box.



•
 
 Choose the correct parameters from the “Data” menu.



•
 
 Fill in the blanks with the necessary information.







 
Chapter 7: Excel Tables and Charts








Without any kind of visual representation, most presentations are incomplete. You would need to visually display the raw data in themediums that can be interpreted in a single glance, whether it's a table, graph, or chart.



Graphs, charts, and tables are important tools to have, particularly if you have any data that spans several columns and rows.



The graph, chart, and table features are more like symbiotic siblings in the Excel system. You'll need them to pull out the charm of your work's brevity.



Microsoft Excel could be used to evaluate large volumes of data and shifting the data range to a table is one of the strongest features for all of this. You can quickly sort and filter your data with tables, add new records, and see your charts and PivotTables updated automatically, making it easier to organize and view your data.



Excel tables are frames for the data you enter. Tables inform Excel that all of the data it receives is associated. The only factor that connects the data without a table is their proximity to one another. Since your worksheet is organized in rows and columns, you might mistakenly believe that the data is already in a table. However, unless you specifically make it so, data in a tabulated form is not a real "table."



A table in Excel is a unique entity that operates as a system that helps you handle the table's details independently of the rest of the worksheet information. The screenshot below shows the difference between a regular range and a table format:


[image: Excel table vs. a range]



The table is styled, which is the most noticeable difference. On the other hand, an Excel chart is something more than a set of formatted data with headings. Within whichyou'll find a slew of useful features:



	
Excel tables are dynamic by default, which means they expand and contract when adding and subtracting rows and columns.


	
Visual filtering with slicers; integrated sort and filter tools.


	
Inbuilt table styles make formatting convenient.


	
When scrolling, column headings remain visible.


	
Quick totals enable you to quickly sum and count data and find the average, minimum, and maximum values.


	
Calculated columns enable you to run a formula in one cell to compute an entire column.


	
Calculations that are easy to read aredue to a specific syntax that utilizes table and column names instead of cell references.


	
When you add or delete data from a table, dynamic charts change automatically.





7.1
 
 
 
How to Create a Table in Excel?




To covert therange of cells into a table, follow the steps below with the source data arranged in rows and columns:



	
Choose a cell from your data set.


	
In the Tables group of the Insert tab, select the Table button or use the Ctrl + T shortcut.


	
The Create Table dialogue box appears, with all of the details pre-selected; you can change the range if required. Ensure the My table has a headers box checked whether you choose the first row of data to become the table headers.


	
Choose OK.





As a result, Excel converts the data into an actual table with the following default style:


[image: A range is converted into an Excel table.]



Notes:
 Before creating a chart, clear and prepare the data by removing blank rows, giving each column a meaningful name, and ensuring that each row includes details regarding a single record. When you insert a table, Excel retains all of the current formattings. To get the best results, delete any previous formatting, such as background colors, so it doesn't clash with the table theme. There is no limit on how many tables you can have per sheet; you can have as many as you need. Inserting at least one blank row and one blank column between a table and other details makes sense for greater readability.



7.2
 
 
 
Integrating or Creating a Dataset




Before youstart creating a chart, you'll need a suitable dataset. You should add appropriate column headers to the data if you choose to use features like the filter or sort tool. Using Excel's import feature, you can easily incorporate data from an external source. To do so, navigate to the "Data" tab and select the "Get Data" option.



After selecting an import type, you must specify the file's location, the database server's or Web resource's address, or the service's account.



You can also manually type the data into the new Excel table. A small dataset of ten customers is made to explain through example. The name, age, revenue, and year of the customer's first transaction are listed in the table.



Small databases could be easily imported into Excel by typing them manually.



Formatting a Dataset as a Table



You should translate the dataset into a formatted Excel table after it's been inserted. To do so, select the entire dataset by clicking and holding the left mouse button, then select all of the Excel cells you wish to convert:



The green border shows the chosen cells in Excel. In comparison, except for the first cell selected, all cells are greyed out. After selecting the dataset, go to the "Home" tab, and press the "Format as table" icon. Excel will then display you a list of the predefined types that are available:



Rather than using the default Excel types, press the "New Table Style" button to make your table format.



Confirm the cells in the dataset (For this example, from A1 to D11 cells) and click the “My table has headers” checkbox if you already have titled the columns of the dataset in the dialogue box that appears. Then press "OK" to create the Excel table you want:



7.3
 
 
 
How to Use and Remove Sort and Filter Functions?




Excel automatically adds a filter and sort function when you generate a formatted Excel table for the dataset. This function allows you to do sorting on the values of individual columns numerically or alphabetically, as well as filter them based on your parameters. Select the option you choose to use by clicking the drop-down arrow icon within the header line of a column.



You will sort customers by revenue (highest to lowest) in the Excel table in this example by selecting the arrow icon in the Sales column and choosing “Sort largest to smallest”:



Excel will suggest the sorting process (numerical or alphabetical) that best suits the table column values.



The filter function, like the sort of function, distinguishes between text and number filters that you use depending on the contents of the column. For example, in the Excel table in this guide, you may use this function to only show customers under the age of 50.



Choose “Number Filters” and then “Is less than” to achieve this. Enter the value "50" in the "Custom AutoFilter" dialogue box that appears, then click "OK" to confirm the filter:



You can remove a filter from your Excel table at any time by pressing the arrow icon beside the column heading and then pressing the “Clear Filter From Column Name” option.



You can also disable the filter and sort functions in your Excel table if you don't want to use them. First, use the drop-down arrow icon to pick one of the cells, then press “Sort & Filter” in the upper menu bar (on the Home tab). Then, from the drop-down screen, choose "Filter" to disable the functions then hide the icons.



From the "Select & Filter" menu, you can switch off the sort and filter functions at any time.



Adding a Totals Row to an Excel Table



One of the benefits of utilizing a formatted Excel table is that you can include a totals row that displays the outcomes of various measurement options selected from a drop-down list automatically. You can show the sum, average, unique individual values, and minimum and maximum values. For adding a complete row to the Excel table, right-click on any cell and choose "Table" and "Totals Row" from the menu section:



Instead of using the default measurement options, you can use the Excel functions to generate your variants.



The usual drop-down arrow icons are included in the totals row. In the table column for which you want to choose a calculation option, click this button. Then choose whether or not to display the calculation's result in the row. Excel is used to measure the averages for the age and income of the consumers in the table in the following example:


[image: ]



By clicking “None,” you will delete the entries from the totals row at any time.



7.4
 
 
 
Creating Charts From the Excel Tables




The advantage of having a formatted Excel table is that you can display the data in charts that adjust automatically when the table or table values change. To make a dynamic chart, follow these steps:



	
Click the "Insert" button.


	
Choose all of the rows on which you want to build a chart.


	
In the “Charts” portion of the ribbon, click “Recommended Charts” and choose the chart type you wish to use. Alternatively, you should choose one of the chart icons from the drop-down menu.





By right-clicking the chart or a particular chart element, you can adjust the design or form of the chart as well as the captions at any time.



How to Remove Formatting From the Excel Table



You can delete the formatting of these cells at any point if you do not require some (or any) formatting in the Excel table or if you mistakenly formatted cells. The "Home" tab of the ribbon contains this feature. It may be seen in the following ways:



	
Choose the cells you want to remove the formatting from.


	
In the "Editing" segment, click the "Clear" tab.


	
From the drop-down menu, choose "Clear Formats."





7.5
 
 
 
Using Pivot tables in Excel




Conventional Excel tables, which are sometimes too inflexible for anyone who may analyses large amounts of data, quickly reach their limits. Pivot tables with advanced features are the ideal option. Pivot tables in Excel show their maximum ability to interpret and prepare data: they may be used to compress data and refine the presentation as required on a case-by-case basis. Pivot tables make work that is normally complicated with traditional tables simple. Pivot tables enable users to adjust the way data is displayed without having to change the data themselves. The basis for this is often a separate, very simple-looking table that holds the whole data collection. Additional functions in Pivot enable the data to be sorted, filtered, and presented in various ways. The idea that the data can only be displayed independently is an essential aspect of learning pivot Excel. Changes to the pivot table would not add additional data to the initial spreadsheet (for example, duplicate data) or erase old data (for example, if the data is filtered).



Creating a Pivot Table



As soon as you learn how pivot works, creating a pivot table in Excel is easy. A pivot table is often built on a set of data with several columns. The name of the respective division must appear in the first row of the column. This is where the pivot table gets its data from automatically. It's also a good idea to use the "format as table" feature to format the table and give it a name. This makes the process simpler, mainly when dealing with several data sets.



Excel's pivot table is built on a data set. To make things easy to work with, convert this into a table.



There are two ways to createa pivot table in Excel: use the table tools or navigate the PivotTable function in the "Insert" tab. This is only a choice if the data collection has been formatted as a table. The function "Summarize with PivotTable" is noticeable here. This opens the same pane, but the corresponding part is already chosen. Users will choose where the latest pivot table may appear in the template: inside a current spreadsheet or a new one.
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Go to Pivot Tables Field Pane and click the field name checkbox to add a field to the Pivot table. If you choose to shift the field from one place to another, drag it with your mouse to the desired spot.



The Pivot Chart



The pivot chart is a visual representation of the Pivot table's results. Follow the steps below to generate a pivot chart from a pivot table:



	
In the Pivot table, choose a cell.


	
Choose pivot chart from the Insert menu.


	
Then select OK.





Using Slicer on Pivot tables and Tables



To filter content on tables or Pivot tables, use the slicer feature. It appears to be a button on the Excel worksheet that allows you to sort results.



	
Choose any cell on the table or Pivot table to use the slicer.


	
Choose Slicer from the Insert menu on the Home page.


	
Select the area you wish to view from the checks box in the Insert Slicers dialogue box.


	
Then press the OK button.





Working With Charts



It's easy to make a chart in Microsoft Office Excel. When creating a chart in Excel, you have a variety of chart formats to choose from. To name a few, Excel has Pie, Line, Bar, and Column charts. Data can be simpler, more interesting, and easier to interpret by displaying it in a table. Charts will also assist you in evaluating the data and comparing various values.



Understanding Charts



Excel has various chart formats from which to choose, allowing you to find the one that best suits your results. You must first learn how various charts are used to use them efficiently.



Types of Charts



	
Column charts
 To display info, it usesvertical bars. They may deal with a wide range of data, although they're more often used for data comparison.


	
Line charts
 are great for displaying trends. Lines connect the data points, making it easier to see if values are growing or reducing over time.


	
Pie charts
 make comparing proportions easy. Each value is represented as a slice of pie, making it simple to see the values make up a percentage of the total.


	
Bar charts
 They act in the same way as column charts, but instead of vertical lines, they use horizontal bars.


	
Area charts
 are identical to line charts, except with the difference that the spaces between the lines are filled in.


	
Surface charts
 enable you to visualize data in a 3d format. They work well for large data sets because they enable you to display a lot of data at once.





To Insert a Chart



	
Make a list of the cells you need to chart, including column and row labels. These cells would be the chart's source data.


	
Choose the desired Chart command from the Insert page.


	
From the drop-down menu, choose the chart style you like.


	
The worksheet will be updated with the chosen chart.





Note:
 If you're unsure which chart to utilize, the Recommended Charts command may suggest a few options depending on the source data.



Chart Layout and Style



You may like to alter a few things in the way the data is presented when you insert a chart. The Design tab makes it simple to change the layout and style of a chart.



Excel helps you incorporate chart features such as chart names, legends, and data marks to render the chart easier to read. To add a chart element, go to the Design tab and pressAdd Chart Element command, then choose the required element from the drop-down list.



Double-click the placeholder for editing a chart element, such as a chart title, and start typing.



	
You can use one of Excel's predefined formats if you don't want to add chart elements individually. Simply choose the requiredlayout from the drop-down menu after clicking the Quick Layout command.


	
Excel also has a number of chart types that you can use to change the look and design of the chart quickly. To change the chart type, go to the Chart styles group and select the required style. The chart layout shortcut buttons can also easily connect chart elements, alter the chart type, and filter the data in the chart.





Other Chart Options



There is a slew of other options for creating a personalized and organized chart. You can rearrange data in a table, adjust the chart style, and even shift the chart to a different position in the workbook using Excel.



To Switch Row and Column Data



You may want to adjust the way charts group the data from time to time. The Book Sales results, for example, are divided by year in the chart below, with columns for each type. You may require changing the rows and columns such that the table groups the data by category and has columns for each year. The data is the same in both cases; the chart is only arranged slightly.



	
Choose the graph you want to change.


	
Choose the Switch Row/Column command from the Design tab. The columns and rows will be switched.





To Change the Chart Type



It's simple to switch to a different chart format if the data isn't well adapted to a particular chart. Change the chart from a Column chart to a Line chart in this case.



	
Choose the Change Chart Type command from the Design tab.


	
You'll see the Change Chart Type dialogue box appear.


	
The chart style you choose would appear.





To Move a Chart



A new chart will arise as an entity on the same worksheet, containing the source data whenever you insert new. You can also move the chart to a new worksheet to keep your data more organized.



	
Choose the chart you'd want to move.


	
Then choose the Move Chart command from the Design tab.


	
The dialogue box "Move Chart" will appear. Choose the chart's desired location.


	
Choose OK.


	
The chart would be shown in the chosen location.





7.6
 
 
Inserting Smart Art Graphics




Graphics



Smart Art Graphics are pre-made graphics showing associations, cycles, diagrams, pyramids, and lists in a spreadsheet or workbook. Pre-entered data from the spreadsheets are not used or included in these graphics. Most of thedata that will be entered to them will be enteredby hand. To add a Smart Art Graphic to your document, go to the Insert tab and select the Smart Art feature (and type of). When you open the tab, it will show in a highlighted green on your top toolbar, along with all of the various graphic options.



You will use a graphic by clicking on the button, which will display on the spreadsheet you're working on. With the graphic, a small dialogue box will open, giving you the option to adjust the data that will appear within the graphic. The default text may reside in the graphic if you do not insert data in this dialogue box. If the dialogue box is unintentionally closed, just select the button on the left-hand side of a graphic to bring it back up on the page.



To Insert Images



Select the desired image from the location where it is placed by going to Insert > Picture > Picture from File.



The image will be directly placed into your file, where you can resize it as required









 
Chapter 8:

 
Formulas and Functions








The ability to determine numerical values using formulas is one of Excel's most essential functions. Working with Excel Formulas will take the experience of the software to a new level. Excel is designed on a base of formulas. In your workbooks, formulas are used to measure cells, numbers, and other data. Built-in algorithms (usually in the form of prefixes) are inserted into formulas to conduct a number of calculations.



8.1
 
 
 
Simple Formulas




Excel can subtract, add, divide, and multiply like a calculator. If you're new to Excel, creating formulas is one of the first tasks you can learn. This book will show you how to create basic Excel formulas and calculations and how to create simple formulas using cell references. At its core, Excel is a massive calculator. Treating each cell in a worksheet as a single calculator is a simple way of thinking about Excel. Since an Excel table has millions of cells, you have to deal with millions of different computers. You can even make formulas that link various cells (e.g., apply value to the cell number). In different worksheets, you can create formulas that connect cells. In addition, you can create formulas in different workbooks that connect cells.



Mathematical Operators



For formulas, Excel uses regular operators such as the plus sign (+), a forward slash for division (/), the minus sign (-), an asterisk for multiplication (*), and a caret (^)for exponents.
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In Excel, all formulas should start with an equal sign (=). This is because the formula and the result or value it determines are included in, or equivalent to, the cell.



Understanding Cell References



You can manually generate basic formulas in Excel (e.g., =2+2 or =5*5); most formulas are created using cell addresses. Also called making a cell reference. Since you can adjust the value of referenced cells despite needing to rewrite the calculation, using cell references ensures that the formulas are always accurate.
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In Excel, you can generate a number of basic formulas by integrating a mathematical operator into cell references. As seen in the examples below, formulas may also provide a variety of cell references with numbers:
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To Create a Formula



	
Choose the cell where the formula will be entered.


	
Type the equals symbol (=) in the cell. Take note of how it appears in the cell as well as the formula bar.


	
In the formula, type the cell address of the cell you want to reference first.


	
A blue border will surround the referenced cell.


	
Enter the mathematical operator you want to use.


	
In the formula, type the cell address of the cell you want to reference second. A red border will surround the referenced cell.


	
On your keyboard, press Enter. The value of the formula will be expressed in the cell after it has been calculated.





Note:
 If a formula's outcome is too large to fit in a cell, it will display as pound signs (#######) rather than a value. This indicates that the column is too narrow to represent the contents of the cell. To see the cell content, simply increase the column width.



Modifying Values With Cell References



Cell references have the distinct benefit of allowing you to update content in your worksheet without attempting to rewrite formulas.



TIP: Since Excel does not often warn you whether a formula has an error, you must double-check all of the formulas.



To Create a Formula Using the Point-and-Click Method



Instead of manually entering cell addresses, you can simply point and click on the cells you want to use in your formula. When creating formulas, this approach will save a lot of time and effort. A formula is developed in the example below to determine the cost of buying several boxes of plastic silverware.



	
Choose the cell where the formula will be entered. Cell D3 is selected in this case.
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First, Type the equals sign (=)


	
In the current case, choose cell B3 as the first cell to reference in the method. A dotted blue line will appear across the referenced cell, and the cell address will show in the formula.


	
Enter the mathematical operator you choose to use. The multiplying sign (*) has been typed in this case.


	
In the current case, choose cell C3 as the second cell to reference in the formula. A dotted red line will appear across the referenced cell, and the cell address will appear in the formula.


	
On the keyboard, press Enter. The value of the formula will be shown in the cell after it has been calculated.





With the fill handle, you can copy formulas to adjacent cells, which can save you a lot of time and effort if you still need to do the same calculation several times in a worksheet.



To Edit a Formula



It's possible that you'll want to change a current formula at some point. In the example below, you'll need to fix an incorrect cell address in the formula.



	
Choose the cell that contains the formula you want to change.


	
To edit the formula, click the formula bar. You may also open and edit the formula directly in the cell by double-clicking it.


	
A border will accompany any referenced cells.


	
Press Enter on the keyboard or click the Enter command in the formula bar when you're done.


	
The formula will be changed, and the new value in the cell will be shown.





Note:
 If you change your mind, you can cancel your formula by pressing the Esc key on your keyboard or clicking the Cancel command in the formula bar. You should hold the Ctrl key and click to see any of the formulas in a spreadsheet (grave accent). The grave accent key is usually found in the keyboard's upper-left corner. You will return to the standard view by pressing Ctrl+ again.



8.2
 
 
 
Complex Formulas




A simple formula, such as 7+9, is a mathematical equation with just one operator. A complicated formula, such as 5+2*8, has more than one logical operator. When a calculation contains several operations, the sequence of operations informs Excel which one to calculate first. You must consider the sequence of operations to use Excel to measure complicated formulas.



Order of Operations



The below is the sequence in which Excel calculates formulas:



	
Parenthetical operations are those that have parentheses around them.


	
Exponential equations (for instance, 3^2)


	
Division and multiplication, whichever falls first,


	
Whichever comes first, addition and subtraction





Creating Complex Formulas



You'll notice how Excel calculates a complex formula using the sequence of operations in the example below. You must measure the cost of sales tax on an invoice in this example. In cell D4, write the formula =(D2+D3) *0.075 to achieve this. To measure the sales tax cost, multiply the total price of all goods by the 7.5 percent tax rate (which is written as 0.075).
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Note:
 Entering complicated formulas in the correct sequence of operations is particularly necessary. Excel cannot measure the outcomes correctly if this is not done. If the parentheses are not used in this case, the multiplication is done first, and the result is wrong. The easiest way to specify which Excel calculations will be done first is to use parentheses.



8.3
 
 
 
Functions




A function is a formula that conducts calculations of specific values in a predetermined sequence. Excel has a number of valuable functions for efficiently calculating the average, sum, count, maximum, and minimum value for a range of cells. You'll need to know the various aspects of a function and construct arguments to determine values and cell references to use functions correctly.



The Parts of a Function



A function should be described in a specific way to operate correctly, known as syntax. An equal sign, the name of the function (for example, SUM), and arguments are the simple syntax for a function. The detail that is required to determine is included in the arguments.



Working With Arguments



Arguments must be enclosed in parentheses and should refer to all individual cells and cell ranges. Depending on the syntax needed for the function, you can add one or more arguments. The function =AVERAGE(B1:B9), for example, calculates the average of values in the B1:B9 cell range. There is just one argument to this function.
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A comma must be used to distinguish several arguments. The following example adds the values of all the cells of three arguments.
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Common Excel Functions



Excel offers a wide range of functions. Some of the commonly used functions are:



	
AVERAGE:
 Calculates the average of all the values in an argument. This Function equates the cells' sums, and by the number of cells in an argument result is divided.


	
SUM:
 sums up all of the values in the argument's cells.


	
COUNT:
 This function calculates the number of cells in the argument that contain numerical details. This function can be used to quickly count the number of items in a cell set.


	
MAX:
 This function returns the value of the largest cell in the argument.


	
MIN:
 This function returns the value of the lowest cell in the argument.


	
SUMIF:
 This function adds all the values in a range of cells that satisfy a set of parameters. =SUMIF (range,criteria,[sum range]) =SUMIF(range,criteria,[sum range]) =SUMIF(range,


	
AVERAGEIF:
 Calculates the average value over the range of cells that follow the requirements.


	
=AVERAGEIF (range, criteria,[averagerange]) =AVERAGEIF(range,criteria,[average range]) =AVERAGEIF(range


	
DAYS:
 This function calculates the number of days between two dates.


	
NOW:
 Returns the latest date and time on the system.





To Create a Basic Function



A basic function has been developed using the AVERAGE function to measure the average price per unit to collect recently purchased goods.



	
Choose the cell where the function will be placed.


	
Type the equals sign (=) and the function name you choose to use. You may also select a function from a collection of suggested functions that appears when you type below the cell. Type =AVERAGE for this case.


	
Inside parentheses, type the cell range for the argument. In this case, you'll need to type (D3:D12).


	
On the keyboard, press Enter. The function will be executed, and the output will be shown in the cell.





To Create a Function Using the AutoSum Command



The AutoSum command incorporates the most common functions, such as AVERAGE, SUM, MIN, COUNT, and MAX, into your formula automatically. A function has been created using the SUM function to measure the total cost for a list of recently purchased goods in the example below.



	
Choose the cell where the function will be placed.


	
Click the arrow next to the AutoSum command in the Editing group on the Home page and select the desired function from the drop-down list. Select Sum for this case.


	
The cell will display the chosen function. The AutoSum command will choose a cell range for the argument if it is located logically. You can also type the required cell range into the argument manually.





On the keyboard, press Enter.



8.4
 
 
 
The Function Library




Although Excel has hundreds of functions, the ones you use the most can be determined by the type of data in your workbooks. There's no need to master every single function, so getting a better understanding of the various forms of functions can help you develop new projects. From the Formulas tab's FunctionLibrary, you can search for functions by types, such as Logical, Financial, Date Text, & Time, and more.



Click the Formulas tab on the Ribbon to access the Function Library. The Function Library will now appear on the screen.



	
The command Insert Function helps you browse for functions using keywords if you're having difficulty locating the correct one.


	
The AutoSum command returns results for basic functions like AVERAGE, SUM, and COUNT automatically.


	
The Recently Utilized command allows you to use functions that you've used recently.


	
The Financial category includes functions regarding financial calculations such as calculating a payment (PMT) or a loan's interest rate (RATE).


	
The Logical type includes functions that check claims for a value or state. For instance, if an order is over $50, add $4.99 for delivery; though, if the order is over $100, do not charge shipping (IF).


	
The Text type includes functions that execute tasks for text in arguments, such as replacing the text (REPLACE) or translating text to lowercase (LOWER).


	
The Date & Time-division includes functions for dealing with dates and times, such as the latest date and time (NOW) and seconds (SECOND).


	
The Lookup & Reference division includes functions that return information for searching and referring. You may apply a hyperlink to the cell or returns the value of the intersection of rows and columns (INDEX).


	
Functions for numerical statements are used in Math and Trig groups. You can, for example, round numbers, multiply subtotal, find Pi's value, etc.


	
More Functions includes additional functions in the Engineering, Statistical, Information, Cube, and Compatibility categories.





To Insert a Function From the Function Library



	
Choose the cell where the function will be located.


	
To access the Function Library, go to the Formulas tab on the Ribbon.


	
Select the desired function type from the Function Library group.


	
From the drop-down menu, choose the desired function.


	
The Arguments for Functions dialogue box will appear. You can enter or assign the cells that will set up the arguments in the function from here.


	
Click OK when you're done with the arguments.


	
The function would be operated, and the output will be shown in the cell.





Functions, like formulas, may be copied to nearby cells. Hover your cursor over the function cell, then press, hold, and move the fill handle over the cells you'd like to fill. The function will be duplicated, and the values for specific cells will be determined in reference to their rows or columns.



The Insert Function Command



If you're having difficulty locating the correct function, you can use the Insert



Function command to check for it by keyword. This order, although incredibly helpful, can be a little challenging to use at times. You may have more chances searching the Function Library if you don't have any experience with functions. The Insert Function command, on the other hand, may be a helpful way for experienced users to quickly locate a function.



To Use the Insert Function Command



	
Choose the cell where the function will be placed.


	
Click the Insert Function command from the Formulas tab on the Ribbon.


	
A dialogue box for inserting a function would appear.


	
Type a few keywords that describe the computation you want the function to do, then press Go.


	
Look at the results to locate the function you like, then press OK.


	
The Arguments for Functions dialogue box will appear.


	
Click OK when you're done.


	
The function will be analyzed, and the outcome will be shown in the cell.





8.5
 
 
 
Commonly Used Excel Formulas




1. SUM



The SUM formula works just as it is expected. It helps you to add two or more numbers.



Formula: ==SUM (A1:B5) or SUM (A1, B1) or =SUM (5, 5) or



In this formula, you can even use cell references.



2. COUNT



The count formula just countsthe number of cells that have numbers in them in a range.
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3. COUNTA



In a range, the number of cells that are not empty is counted. Cells containing numbers or all other characters would be counted.



The COUNTA may be used for any kind of data. Regardless of the data type, it lists the number of cells that aren't empty.



4. LEN



LEN formula determines how many characters are in a cell. This covers spaces as well.



Take note of the differences in the formula results: 10 characters with no spaces between the words and 12 characters with spaces between the words.



5. VLOOKUP



VLOOKUP allows you to scan your spreadsheet for specific data. You might, for example, check for the price of a single commodity if you have a list of items with prices.



To find the cost of the Photo frame, you could use VLOOKUP. Since this is a simple example, you will hopefully already have seen the price is $9.99. You'll be able to use VLOOKUP on larger, more complicated spreadsheets until you've learned to use it, and that's when it'll be beneficial.



You'll begin with an equal sign (=) like you would with any formula. Then type the name of the formula.



The data is included in the second argument, which is a cell range. Your data is in the format A2:B16 in this example. Every argument must be separated by a comma, just like every other function.



It's worth noting that VLOOKUP would always look up the first column in the range. In this case, it will look in column A for the term "photo frame". You will need to shift the columns in certain situations to include the correct data in the first column.



The index number of the column is the third argument. It's easier: 1 is the range's first column, 2 is the second column, and so on. You're looking for the price of an object in this situation, and the prices are shown in the second column. As a result, your third argument would be 2.



The fourth statement, TRUE or FALSE, informs VLOOKUP whether or not to look for estimated matches. It will search for close matches if it is TRUE. This is usually useful if the first column contains sorted numerical values. The fourth argument should be FALSE because you're only looking for exact matches. Close the parentheses now, as this is the last argument.



That's what there is to it! So, when you click enter, the result should appear, which is 9.99.



8.6
 
 
 
IF Statements




Returns True if the logical statement is true and returns False if the logical statement false.



Example:



Consider the case of a salesperson who consists of a quota to fulfill. You placed the revenue next to the name using VLOOKUP. You will now use an IF statement like this: "IF the salesperson met their quota, says "Met quota," otherwise, says "Did not meet quota."



This IF statement would determine whether or not the first salesperson reached their quota. Then copy and paste this formula into each of the list's entries. For each salesperson, it will be different.









 
Chapter 9: Excel Text Functions








When it comes to editing text strings, Excel has a lot of options. Excel is mainly concerned with numerical data, although you can also encounter data that contains excessive amounts of text. Text Functions in Excel may assist you in quickly simplifying the matter. The Excel Text function is part of the String Formulas category. The Text Function's job is to translate a numeric value to a string, as the name implies.



Text data is manipulated using these simple Excel features. The table below lists some of the most common string functions.





	

S/N



	

FUNCTION



	

DESCRIPTION






	

1



	

RIGHT



	

Returns a given number of characters from a string's end (right-hand side).






	

2



	

LEFT



	

Returns a given number of characters from the starting (left-hand side) of a string.






	

3



	

MID



	

From a specified start position and duration, retrieves the number of characters from the center or middle of a string.






	

4



	

FIND



	

The starting location of a text string inside another text string is returned. It's important to note that this role is case-sensitive.






	

5



	

ISTEXT



	

If the provided parameter is Text, it returns True.






	

6



	

REPLACE



	

Replaces a portion of a string with another string specified.









9.1
 
 
 
Syntax of Text Function




=TEXT (value, format_text)



The TEXT function requires two arguments/parameters:



	
Value
 : You'll need a numeric meaning to translate to text. This value may be a number, a date, or a reference to a numeric value in another cell.


	
Format text
 : The format code you want to add to the value you've given. It should be expressed in double quotation marks at all times.





Excel has many text functions that come in handy if you need to update or connect to the text strings. Here's how to put them to good use.



9.2
 
 
 
Joining Strings in Excel




The & operator can be used to connect two separate text strings.



	
Insert the & operator in the cells where you choose to enter strings. The Text function will look like this to connect cells A1 and B1:





=A1&B1



	
You must use the “ ” operator to add character (such as space).





The Text function will look like this to connect cells A1 and B1:



=A1&" "&B1


[image: Joining Strings in Excel]



9.3
 
 
 
Using the LEFT Function




The LEFT function comes in handy when you want a certain number of characters on the left side of a string.



	
Choose the LEFT function from the drop-down menu.


	
Choose the cell from which you'd like to remove the leftmost characters and the number of characters you'd like to extract.





Your LEFT function will look like this if you were to remove the first five characters from the string in cell A1:



=LEFT (A1, 5)


[image: Extracting the leftmost characters using the LEFT Function]



9.4
 
 
 
Using the RIGHTFunction




The RIGHT function can be used if you want a certain number of characters on the right side of a string.



1. Choose the RIGHT function from the drop-down menu.



2. Choose the cell from which you'd like to remove the rightmost characters and the number of characters you'd like to extract.



Your RIGHT function will look like this if you were to remove the last seven characters from the string in cell A1:



=Right (A1, 7)


[image: Extracting the rightmost characters using the RIGHT Function]



9.5
 
 
 
Using the MIDFunction




Use the MID function to remove a substring of a given string, beginning with thecharacter you specify through number and ending with an amount you specify.



Use =MID(A1,11,6) to retrieve text at location 11 (G) in the illustration below and separatedsix characters (Great). It's also worth noting that Excel treats spaces as positions.



9.6
 
 
 
Using the LEN Function




The LEN function is beneficial for determining the length of a string.



	
Add the LEN function.


	
Choose the cell wherever you want to determine the string's length.









Your LEN function will look like this if you were to find the length of the string in cell A1:



=LEN(A1)


[image: Find out the length of a string using the LEN Function]



It's worth noting that the value contains special characters like space.



9.7
 
 
 
Using the FIND Function




The FIND function comes in handy when you need to search the position of a substring.



	
Use the FIND function.


	
In the cell, wherever you want Excel to look, type the characters (substring) you're searching for in your string.





Your function will look like this if you were to locate the position of “Great” in cell A1:



=FIND ("Great", A1)



Take note of how Excel put the string “Great” at position 1.



9.8
 
 
 
Using the SUBSTITUTE Function




The SUBSTITUTE function is highly known for replacing a specific substring of the text with a different substring.



	
Add the SUBSTITUTE function.


	
Choose the cell containing the text string you want to replace.


	
Then, in quotations, compose the old text and the current text you intend to replace it with.





For instance, if you choose to replace the string "United Nations" in cell A1 with "UN," your substitution function will look like this:



=SUBSTITUTE (A1,"United Nations","UN")



9.9
 
 
 
Adding Zeros Before Numbers of Varying Lengths




Any zeros added before the numbers are automatically replacedby Excel, as youall know. The TEXT function, on the other side, comes in handy if youneed to keep those zeros. Let's look at an example and see how this function works.



There is a 9-digit product code to work with, but Excel removed the zeros before it. You can translate the product code into the 9-digit number using TEXT, as seen below:


[image: TEXT Function - Variable Number Lengths]



The format code comprising 9-digit zeros is provided in the above formula, where some zeros equal the number of digits required to display.



Some Important Points About Text Formula



	
Since the TEXT formula turns a numeric expression into formatted text, the outcome cannot be used for calculations.


	
A #NAME? Error is thrown if the quotation marks across the “format text” argument are omitted.


	
The asterisk character (*) cannot be used in the format text argument.


	
The TEXT function is language-specific. It necessitates the use of date and time format codes specific to each region.









	






Chapter 10: Excel Date and Time Functions








When it works with dates and times, Microsoft Excel has a variety of functions. Each function executes a simple operation, and by integrating many functions into a single formula, you can solve many complex and vital problems. To evaluatedates in Excel, the DATE function is important to learn. Excel does not hold the year, month, or day for a day, nor does it specifically contain weekday details in the cell, as you probably know. On the other hand, Microsoft Excel keeps dates as serial numbers, which is the critical cause of confusion.



Since not all Excel date functions will accept dates inserted as text values, including dates explicitly in calculations is not advised. Instead, use the DATE function to obtain a serial number describing the date, which Excel can recognize and manipulate.



10.1
 
 
 
Date Time Functions




Date values are manipulated using these functions. Some of the more common date functions are mentioned below.



Excel's Primary Function for Calculating Dates



	

DATE function






Get Current Date and Time



	

NOW

 :
 Returns the current time and date.


	

TODAY

 :
 Returns today's date.





Convert Dates to/from the Text:



	

DATEVALUE

 :
 Converts a textual date into a date format.


	

TEXT

 :
 A function that transforms a date to a text value.





Retrieve Dates in Excel



	

DAY

 :
 Returns the month's day.


	

MONTH

 :
 The month of a specific date is returned.


	

YEAR

 :
 The year of a particular date is returned.


	

EOMONTH

 :
 Returns the month's last day.


	

WEEKDAY

 :
 The weekday is returned.


	

WEEKNUM

 :
 Returns the date's week number.





Calculate Workdays



	

WORKDAY.INTL

 :
 From the start of the day, returns the date, and weekdays with custom weekends.


	

WORKDAY

 :
 Returns date and number of working days in the past or future.


	

NETWORKDAYS

 :
 Between two dates, returns the number of working days.


	

NETWORKDAYS.INTL

 :
 The number of working days in two dates of custom weekends is returned.





Calculate Date Difference



	

DATEDIF

 :
 Compares two dates and returns the gap between them.


	

EDATE

 :
 Returns date and months before or after the start date.


	

YEARFRAC

 :
 Determines the year's fraction between two dates.





Time Functions



	
TIME function:
 The serial number of a specific time is returned.


	
TIME VALUE function:
 Converts a text-based time to a serial number.


	
HOUR function:
 This function converts a serial number into an hour.


	
MINUTE function:
 This function converts a serial number into a minute.


	
SECOND function:
 Converts serial number to second.





10.2
 
 
 
Excel DATE and Time Function Syntax




DATE (year, month, day)



The DATE function in Microsoft Excel returns the serial date value for a date. It is an Excel built-in function that is classified as a Date/Time Function. It can also be used in Excel as a worksheet function (WS). It can be used in a formula in a worksheet cell.



Year



represents the date's year. The year argument is interpreted by Excel using the date system you have set up on your system. Microsoft Excel for Windows utilizes the 1900 system by default. The date schemeincluded in this system is:



	
If the year falls between 1900 and 9999 inclusively, that value is used.





=DATE (2015, 12, 31), for example, returns December 31, 2015.



	
Excel calculates the year by applying the specified number to 1900 if the year statement is between 0 & 1899 inclusive. =DATE (100, 12, 31), for example, returns December 31, 2000 (1900 + 100).


	
A DATE formula may return the #NUM! Error if the year is less than 0 or greater than 9999.





To avoid ambiguity, always provide four-digit years. If you type "01" or "1" in the year argument, for instance, the DATE formula may return the year 1901.



Month



An integer represents the month of the year, from 1 (January) to 12. (December). If the number of months listed is greater than 12, Excel will add the number to the start/1
 st
  month of the specifiedyear. For examples =DATE (2016, 3, 1) returns the serial number for March 1, 2016 (January 5, 2015 plus 15 months).



To determine if the value entered fora month is smaller than 1, negative or zero, Excel deducts the magnitude of that number of months and adds 1 from the 1
 st
 month of a specific year. For example, =DATE (2015, -5, 1) returns the serial number displaying July 1, 2014 (January 1, 2015, deducted 6 months).



Day



An integer from 1 to 31corresponding to the day of the month.



For a month, the day argument will be supplied as a negative and positive number, and Excel determines its value using the same principles as described for the above cases.



Tip. It might be unnecessary to provide negative values in the DATE Function in the month and day arguments for the formula in EXCEL, but it may end up becoming helpful in some cases, for example, in the complex date formula that adds week numbers to date.



It is included in all recent updates of Excel, including in all releases of Excel, and it is available in earlier releases of Excel as well.



Time



The TIME function in Microsoft Excel returns a decimal number between 0 and 0.999988426, giving a minute, hour, and second value. The result of 0 interprets
 12:00:00 AM
 , and the result of 0.999988426 solves
 11:59:59 PM
 .



The built-in function TIME function in Excel is classified as a
 Date/Time Function
 . It could be used as a WS worksheet function in Excel. The TIME function can be inserted as part of a formula as a worksheet function in a worksheet cell.







The TIME function inMicrosoft Excel has the following syntax.



: TIME (hour, minute, second)
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How Excel Handles Date and Time?




The date serial number, also known as the date-time serial number, is a number that Excel uses to store dates and times.



When you look at a date in Excel, you're looking at a regular number that has been formatted to look like a date. You will see the corresponding date serial number if you adjust the cell format to "General.”



The day is represented by the integer part of the date serial number, while the decimal portion represents the time. The date serial number 1 begins on January 1, 1900, i.e., 1/1/1900 has a date serial number for 1.


[image: Excel Date and Time serial number example]



Dates



Starting on January 1, 1900, Excel assigns a numeric value to each date. The first day of the year 1900 has a numerical valueof 1, the second day of the year 1900 has a numerical valueof 2, and so on. These are referred to as "date serial numbers," They enable us to perform mathematical calculations and then use dates in formulas.



The Date Serial Number column shows the values of the Date column as date serial numbers. 1/1/2017, for example, has a date serial number of 42736. Since December 31, 1899, the 1st of January 2017 has been 42,736 days.


[image: ]



Note
 : If you format a date serial number column as a Date, you'll find that the values are the same as those in the Date column.



 Time



Times are often expressed as decimal fractions, which use a serial number format.



	
Hours:
 For 24 hours equals one day, you can infer that 24 hours has a time a serial number of 1 and can be formatted as a time to show 24:00, 12:00 AM, or 0:00. Whereas 12 hours or 12:00 has a value of 0.50 because it is half of a day, and 1 hour has a value of 0.41666' because it is 1/24 of a day.


	
Minutes:
 as 1 hour is 1/24 of a day and 1 minute is 1/60 of an hour, 1 minute is 1/1440 of a day, or the time serial number is 0.00069444.'


	
Seconds:
 A second is 1/60 of a minute, 1/60 of an hour, and 1/24 of a day. One second is also 1/86400 of a day or 0.0000115740740740741 in time serial number form.




[image: Excel Time serial number examples]



 Date and Time Together



As now you know that how dates and times are handled, you should combine them—ddddd. tttttt



The date and time of January 1, 2012, 10:00:00 AM, for instance, has a date-time serial value:40909.4166666667.



The serial value for the date 1st January 2012 is 40909, and the decimal value forthe time 10:00 AM and 00 seconds is 4166666667.


[image: Excel Date and Time serial number examples]
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How to Enter a Date and Time in Excel?




You can type a date in various ways in an Excel cell, such as 1/1/2015, 1-Jan-2015, or 1-Jan, or January 1, 2015. When you type anything like that in a cell, Microsoft Excel recognizes that you're entering a date and applies the date format to that cell automatically. Excel usually formats the recentlyadded date according to the default date settings in Windows, but it may also keep it exactly as you typed.



The right alignment of the date you entered in a cell, instead of left-aligned text values, is the most noticeable visual indication that Excel has remembered it.


[image: Various ways to enter a date in Excel]



If Excel doesn't accept your input as a date because it appears left-justified in a cell, consider adding a date in a format similar to your default short or long date formats. In the dialog window of Format Cell, these formats are shown by an asterisk (*), and they're easy to find on the Excel ribbon, open the Home tab, and click on Number group.



The Format Cells dialogue, which opens when you press Ctrl + 1, will enable you to quickly adjust the date format later.



Note:
 If a date you've inserted appears in a cell as a series of pound signs (#####), the cell is more definitely too small to accommodate the whole date. To correct this, double-click the column's right border to auto-fit the year, or drag the right border to adjust the column width. If none of these suggestions work, look at other Excel date format troubleshooting options.



Inserting Current Time and Today's Date in Excel



The present date and time can be entered as a static or dynamic attribute in Microsoft Excel. When entering time, you must use the h: mm format. i.e., a colon separates the hour and minutes, with no spaces on each side. When you enter the h: mm variables, the time would be formatted in military time; for example, 2:00 PM is 14:00 in military time.



Excel can format the cell in h:mm: ss if you enter a time that contains a second’s portion, such as 3:15:40.



If you choose to format the time with AM/PM, enter a space after the time frame and either type AM or PM, or use the number format later. Here are some examples:


[image: entering time in excel]



Shortcuts to Insert Today Date in Excel (as a Timestamp)



Let's start by defining what timestamp is. Entering a "static date" that would not alter with time even when the spreadsheet is recomputed is known as timestamping.



So, if you want to enter the latest date and time as the static value that won't change the next day, you can use one of the shortcuts below:



	
Ctrl +;
 Insert the current date in a cell using this shortcut.


	
Ctrl + Shift +;
 Insert the current time using this shortcut.


	
To insert the current date and time, click Ctrl
 +;
 then press the
 Space key
 , and then
 Ctrl + Shift +;




[image: The shortcuts to insert today's date in Excel]



Insert the Current Date and Time, Automatically Updatable



Using one of the following Excel date functions to enter today's date in a way that will always be up to date:



	
=TODAY ()
 : The
 Today date
 is inserted into a cell.


	
=NOW ()
 : inserts the
 current date and time
 into a cell.




[image: Inserting an automatically updatable today's date and current time]



Unlike shortcuts for Excel date, the TODAY and NOW functions also return today's date and time.



Keep in mind the following when utilizing the Excel date functions:



	
The returned date and time are not updated regularly; they are updated when the spreadsheet is re-calculated or re-opened and when a macro containing the function is executed.


	
The functions use the computer clock to get the current date and time.
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Simple Date and Time Math




 You'll noticehow logical it is to execute math operations on dates and times now that you know Excel stores them as serial numbers. Here are a few simple examples:



Adding/Subtracting Days from Dates


[image: simple date and time math in excel]



 You can also directly add/subtract days in the formula, such as =B10+10 or =B11-5. It's preferable to put the values you're modifying in theircell or a designated range.



Subtracting Dates From One Another


[image: subtract dates in excel]



To notice the number of days between two dates, modify the cell's format to General or Number.



Note
 :
 
 The “result” excludes the start day, assuming that the start day is at the end of the day.



Adding Times to One Another



A time serial number is used to input the time being added. In the table below, you'll see that there are no negative times. It's important to remember that you can't show negative times. To instruct Excel to subtract time, you'll need to use the math operator.


[image: add time in excel]



Note:
 As times roll forward to the next day, the time-date serial number becomes >= 1. Cell E28 includes a time-serial number of 1.08333', but only the time part is visible since the cell is formatted to represent time in h:mm: ss.



If you choose to display the cumulative time (like in cell E29), you must put square brackets around the “h” portion of the time format, as shown:
 [h]:mm: ss.



 Subtracting Time From Times



The last result in the table below is ######, which is because it generates a negative time, which Excel cannot represent, although it does return a negative time serial number.


[image: subtract time in excel]



 Subtracting Times From One Another



The last result displays ###### since it produces a negative time.


[image: subtract time from times in excel]
 









 
Chapter 11: Excel Logical Functions








To work with logical values, Microsoft Excel contains logical functions. AND, OR, IF, and NOT are the functions. If you choose to make various comparisons in your formula or evaluate many conditions instead of one, you can use functions. When their arguments are checked, Excel logical functions return TRUE or FALSE, just like logical operators.
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What Is a Condition and Why Does it Matter?




A condition is anexpression that returns true or false when evaluated. The expression canbe a function that checks if the value insertedin a cell is numeric or text, or whether the value is greater than, equivalent to, or less than thespecified value, etc.



After checking the conditions, all logical formulas in Excel can perform a particular function of showing the output as true or false.
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How to UseExcel's Logical Functions




There are up to 9 logical formulas in Excel. To see all of the logical formulas, go to the Formula tab and choose the Logical Function group.



To help you selectthe right formula for thespecific task, here's a quick rundown of what variouslogical function does.



	
ANDfunction:
 The AND formula takes logical inputs then returns TRUE if all of them are true; otherwise, it returns FALSE.


	
ORfunction:
 The OR formula takes logical inputs, then returns TRUE even if only one of them is TRUE, and returnsFALSE only if any of them are FALSE.


	
NOT function:
 The NOT formula takes just one statement and returns one asTRUE or FALSE. The NOT formula shifts true to false and vice versa, reversing the output.


	
TRUE function:
 True formula doesn't accept any input andinstead shows true as a result.


	
FALSE function:
 False, as the true formula, does not take any arguments and only shows false as a result.


	

 If you give a function three inputs, the first of which is the logical argument, this will return true or false. The values which return true or false can then be specified.


	
IFERROR function:
 This function acceptstwo inputs, the first of which is the value, and the second of which is the output that would be shown if the first value is an error.


	
IS function:
 This is the most basic and most important function. This function double-checks each value before rerunning the output as true or false.





Some are widely used formulas, and others are rarely used formulas. Here are some of the most common Excel logical formulas with examples that are explained. If you do a logical test, all of the Excel logical formulas operate based on TRUE or FALSE.
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IF Logical Function in Excel




One of the most common logical functions to address in Excel is the IF function. There are three arguments to supply for IF.The syntax for IF:


[image: Logical IF Example 2]



	
Logical test:
 This is essentially the same as the conditional test.


	
Value if TRUE
 : What could the outcome be if the above logical test in Excel is TRUE?


	
Value if FALSE:
 What could the outcome be if the above logical test inExcel is FALSE?





The IF function is explainedusing a budget for household goods as an example. The IF function has been used to determine whether or not an item is expensive. Assume that items worth more than 6,000 dollars are costly. Those with a price tag of less than 6,000 are the cheapest. The dataset to deal with is depicted in the illustration below.


[image: Logical functions (operators) and conditions in Excel]



• Focus the cursor on cell F4.



• Use the IF function in the following formula.



=IF(E4<6000,"Yes","No")



HERE



	
"=IF (…)"
 the IF functions are called


	
"E4<6000"
 The IF function calculatesthis condition. It verifies that the value of cell E4 (subtotal) is less than 6,000.


	
"Yes"
 If E4 is less than 6,000, that's the value that function might display.


	
"No"
 If the value of E4 is larger than 6,000, the function may display this value.





When you're done, tap the enter key.



The following are the results:


[image: ]
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AND Logical Function in Excel




The syntax for AND function is:



=AND (logical1, [logical2], …)



If all of the conditions are true, the AND Function returns TRUE; otherwise, it returns FALSE. Have a look at AND function incell D2 for illustration.


[image: And Function]



 Explanation:
 If the first value is greater or equal to 60 and the second score is greater or equal to 90, the AND function returns TRUE; otherwise, it returns FALSE.
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OR Logical Function in Excel




The syntax for OR function is:



=OR (logical1, [logical2], …



If all of the conditions are true, the OR function willreturnTRUE; otherwise, it returns FALSE.



Havea look at the OR function incell D2 below for illustration.


[image: Or Function]



 Explanation:
 If only one score is greater than or equivalent to 60, the OR function returns TRUE; otherwise, it returns FALSE.
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Not Logical Function in Excel




In terms of syntax, the NOT function is the simplest Excel function:



=NOT (logical)



TRUE becomes FALSE, and FALSE becomes TRUE, using the NOT function.



Have a look at the NOT function in cell D2 below for illustration.


[image: Not Function]



Explanation: The NOT function in this example reverses the outcome of the OR function.
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Using the XOR Function in Excel




The logical Exclusive OR function is the XOR function. Many of you who are acquainted with some programming language and computer science, in general, can recognize this expression. The definition of “Exclusive Or” might be challenging to understand for those who don't, but ideally, the clarification below may help.



The syntax of the XOR function is similar to OR:



=XOR (logical1, [logical2],…)



Additional logical values are optional; only the first valid logic (Logical 1) is required. You can measure up to 254 conditions in a single formula, which can be arrays, logical values, or references that analyses to TRUE or FALSE.



An XOR formula, in its most basic form, consists of just two logical statements and returns:



	
TRUE if any argument evaluates to TRUE.


	
FALSE if no statement is TRUE or if all claims are TRUE.
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Excel Logical Functions—Facts and Figures




	
Cell references, Boolean values,numeric values, text values, comparative operators, and other Excel functions may be used as arguments for logical functions. However, all arguments must evaluate TRUE or FALSE Boolean values or arraysor references comprising logical values.


	
If a logical function's argument includes some void cells, such values are overlooked. The formula returns a #VALUE! Error if all of the arguments were empty cells.


	
If a logical function's argument includes numbers, zero implies FALSE, while all other numbers, including negative numbers, imply TRUE.


	
If none of the arguments analyze to logical values, a logical function returns the #VALUE! Mistake.









 
 
Chapter 12: Statistical, Numeric, and Financial Functions
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Statistical Functions




Functions, in addition to formulas, are another way to do mathematical calculations in Excel. A quantitative method is applied to a set of cells in a worksheet using statistical functions. The SUM function, for example, is used to add the values in a range of cells. The followingtable contains a list of commonly used statistical functions. When implementing a mathematical process to a set of cells, functions are more valuable than formulas. You'd have to apply each cell position to the formula one at a time if you have used a formula to add the values in a range of cells. If you want to add the values in the few hundred cell locations, this will take a long time. When you use a function, you will quickly highlight all the cells that hold the values you want to sum.



Commonly Used Statistical Functions





	

Function



	

Output








	

ABS



	

A number's absolute value.






	

AVERAGE



	

For a group of numbers, the arithmetic means, or average is used.






	

COUNT



	

The number of numerical character-containing cell locations in a range.






	

COUNTA



	

The number of times a text or numeric character appears in a range of cells.






	

MAX



	

In a group of numbers, the largest numeric value






	

MEDIAN



	

The number in the center of a group of numbers (half ofthe numbers in the group are higher than the median, and half ofthe numbers in the group are lower than the median)






	

MIN



	

In a group of numbers, the lowest statistical value






	

MODE



	

In a group of numbers, the number that occurs the most frequently.






	

PRODUCT



	

Multiplying all of the values in therange of cell locations






	

SQRT



	

The number's positive square root






	

STDEV.S



	

The standard deviation of a set of numbers calculated from the sample.






	

SUM



	

The total of a group's numeric values.
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Financial Functions in Excel




Excel financial functions may be used to perform several financial analyses, including yield calculations, interest rates,investment valuations,internal cost of the return, asset depletion, and payment calculations. On the other hand, these financial functions may be divided into different categories to help you find the one you need.



In general, there are fourinterrelated quantities:



	
Present value (PV),
 which is the current value of the savings or load. This function is used to calculate the size of the debt that will be paid off if a periodic payment is made over a certain number of payments and a specified periodic interest rate is used.


	
Interest rate per period (RATE)
 is a monthly interest rate. This function determines the periodic interest rate needed to pay off a defined present value for a given periodic payment and a specified total number of payments.


	
NPER (number of payment periods)
  The cumulative number of payment periods needed to pay off a defined present value for a given payment and periodic interest rate is calculated using this function.


	
Payment per period
 is the same as
 periodic payment (PMT)
 . For a specified present value, periodic interest rate, and a cumulative number of payments, this function calculates the fixed periodic payment.





12.3
 
 


 
Numeric Functions




These functions work for numeric details, as their names suggest. The table below lists some of the most common numeric functions.





	

S/N



	

FUNCTION



	

DESCRIPTION



	

USAGE






	

1



	

ISNUMBER



	

If the specified value is numeric, it returns True; otherwise, it returns False.



	

=ISNUMBER(A3)






	

2



	

ROUND



	

Rounds a decimal value to the number of decimal points specified.



	

=ROUND (3.14455,2)






	

3



	

PI



	

The value of the Math Function PI() is returned.



	

=PI ()






	

4



	

MEDIAN



	

The number in the center of the set of numbers is returned.



	

=MEDIAN (3,4,5,2,5)






	

5



	

RAND



	

Generates a number between 0 and 1 randomly.



	

=RAND ()






	

6



	

POWER



	

Returns a result of raising a number to a power. Power (number, power)



	

=POWER (3,9)






	

7



	

ROMAN



	

A number is converted to roman numerals.



	

=ROMAN (1984)






	

8



	

MOD



	

When two numbers are divided, the Remainder is returned.



	

=MOD (10,3)











































 
Chapter 13: Common Excel Printing Issues and Waysto Solve Them








A spreadsheet will not print well on time, possibly because you printed it in portrait mode rather than landscape mode. It's possible that a file area was not printed or that printing took more paper than intended. Regardless of what went wrong, the right way can assist you in avoiding multiple printing problems in this software.Excel 365 is used for this reference, although nearly all of the guidance applies to the previous versions of Excel. The next time you have an issue with a printout, try these measures before printing the spreadsheet.



You might want to print a workbook so you can view and share the data offline. The Print pane makes previewing and printing a workbook from Excel simple once you've selected your page layout options.
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To Access the Print Pane




	
Navigate to the File page. A backstage view will be shown.




[image: ]



	
Choose Print. The Print window would open.





Choosing a Print Area



It's important to know exactly what details you want to print before printing an Excel workbook. If your workbook contains several worksheets, you must determine whether you want to print the whole workbook or only the active worksheets. There will be occasions where you wish to print a portion of your workbook's content.
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To Print the Active Sheets




When a worksheet is selected, it is considered active.



	
Choose the worksheet you may want to print from the drop-down menu. Click the first worksheet, press the Ctrl key on your keyboard, and then click any other worksheets you wish to print.




[image: ]



	
Go to the Printing pane.


	
From the Print Range drop-down menu, select Active Print Sheets.


	
Click Print.
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To Print the Entire Workbook




	
Go to the Printing pane.


	
Fromthe Print Range drop-down menu, select the Print Entire Workbook.


	
Choose Print from the drop-down menu.





13.4
 
 


 
To Print a Selection




	
Selecta list of the cells you want to print.


	
Go to the Printing pan.


	
From the Print Range drop-down menu, choose Print Selection.


	
In the Preview window, you'll see a preview of the selection.


	
To print the selection, click the Print icon.





Note:
 If you want, you can configure the print area inadvance to see which cells would be printed when working with Excel. Select the cells you want to print, then go to the Page Layout tab, click the Print Area command, and then Set Print Area.
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Fitting and Scaling Content




To fit the workbook content neatly into a printed sheet, you will need to make minor changes from the Print pane on time. Scaling and page margins are two tools in the Print pane that can help you align and scale the content.



Before Printing,Fittingthe Content



If the printer is cutting off any of your content, you should use scaling to automatically fit the workbook to the page.



	
Go to the Printing tab.


	
From the Scaling drop-down menu, choose the preferred option.Use Fit Sheet on One Page if required.


	
The worksheet would be reduced in size to fit on a single page.


	
Click Print when you're done with the scaling.
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To Modify Margins in the Preview Pane




To make the data fit more efficiently, you may just need to change a single margin. The Preview pane allows you to adjust the margins of individual pages.



	
Open the Print pane and, in the lower-right corner, select the Show Margins button.


	
In the Preview pane, you'll see the page margins. Move the mouse over a margin marker until the cursor changes to a double arrow.


	
To increase and decrease the margin width, click, hold, & drag the mouse.


	
Release mouse. A shift would be made to the margin. You can accommodate an extra column on the page in thiscase.
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How to Verify the Orientation?

 



Before you print the document, make sure it's in the right orientation. To test the landscape, go to the Page Settings option and select Orientation from the list of possible orientations. Then, next to Orientation, click Margins to review the page margins. To the total number of prints, choose option Narrow or choose Custom Margins and enter the values you want. While you're at it, leave some space for your margin.
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How to Put a Page Break in Place?

 



The split is inserted into an Excel sheet with multiple columns or rows that divide at the wrong location when printed to tackle this. To insert a horizontal break, choose the row on which you choose to divide the printout. To insert a vertical one, choose the whole column. Then select Insert Web Split from the Breaks menu in the Web Interface. To remove a page break, pick the corresponding column or lines, go to Breaks, and then Remove Page Break. If you need to remove many page breaks, you can reset all of them under the Breaks line.
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How to Look at Preview?

 



You wantto get an idea of how the printout would look. To access the Print mode, which allows you to see your file, click the Ctrl & F2 keys simultaneously. After that, you can move between sample pages. When you're done, simply press the top left arrow to return to the standard view.
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How to Set or Clear the Spreadsheet’s Print Area?

 



Setting or deleting this region will assist in the correction of a paper that has been printed incorrectly. If you haven't set the correct print area, you'll want to get rid of it. To do so, go to Page Layout and select Print Area, then Clear Print Area.







 
Chapter 14:

 
Excel Tips and Tricks








Microsoft Excel is an essential software program for every enterprise. Some people appreciate Excel's capabilities, considering it to be a valuable method for managing, reporting, and illustrating data tables. On the other hand, others find it tedious and unable to see how Excel will help them beyond keeping the stuff in neat rows and columns. Microsoft Excel software will have the technological advantage you want to get the task done if you're reviewing large amounts of data and trouncing timesheet templates. Here are few more Excel tricks to get you acquainted with how to use Excel so you can work more comfortably and avoid tedious, manual work.
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How to Transpose Rows Into Columns?




When you consist of a spreadsheet with many low-row data, you will decide to convert the items from rows into columns or vice versa. Copying and pasting each header would take a long time, but the transpose function helps you to quickly transfer the row data into columns or the other way around.



To begin, select the column you want to transpose into rows and highlight it. Select "Copy" from the context menu when you right-click it. Then, pick the cells where you want the first row or column to start on your spreadsheet. Select "Paste Special" from the context menu after right-clicking on the cell. You'll see a module emerge, with a transpose choice at the right. Pick OK after checking the box. Your column has been converted to a row or vice versa.
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Using Conditional Formatting: Automatically Changing the Color of Cells Based on the Data




Conditional formatting is an essential aspect of modern Excel Tips and Tricks, and by using it, you can make the data seem simpler.



Conditional formatting allows you to adjust the color of any cell based on the data it contains. For example, if you choose to highlight specific numbers that are above average or in the top 10% of your spreadsheet's results, you can easily do so.



It's also possible to use Excel to use color to distinguish commonalities between rows. You will instantly and easily see any information you find meaningful at a given time using this method.



	
First, choose the cells in the group that you want to use conditional formatting.


	
Choose “Conditional Formatting” from the dropdown selection on the Home menu. (You should make your own rule if you want anything distinctive.)


	
A pop-up window will appear with more information about the formatting rule.


	
When you're done, tap "OK." The results will begin to emerge on their own.
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Combine Cells Using “&
 ”




Data is split out of databases to render it as precise as possible. Instead of displaying a person's full name, a database may display the information as a first name and then the last name in different columns. It may also divide a person's position by state, city, and zip code. Using the "&" sign-in function in Excel, you will be merged cells of separate data into one cell.



The following is a formula with variables fromexample: =A2&" "&B2



Let's take a look at the formula using an example. Assume you choose to merge first and last names in a single column to form complete names. To do so,place your cursor in the empty cell where the full name should appear. Following that, highlight a cell with a first name, type in a "&," and then highlight a cell with the following last name.



But you're not done yet: if all you type=A2&B2, the person's first and last names would not be separated by a space. Using the function =A2&" "&B2 to add the extra space. The quotation marks across space instruct Excel to separate the first and last names with space.



14.4
 
 
 
Hyperlink a Cell to a Website




If you're using a spreadsheet to track social networking or website analytics, a reference column with links each row is monitoring may be helpful. If you paste a URL into Excel, it should be clickable right away. However, here's how to hyperlink terms like the headline of a page or a page title you're monitoring.



Click Shift K when selecting the terms, you want to hyperlink. A box will appear, enabling you to enter the hyperlink URL. Enter the URL by copying and pasting it into this box.



If the main shortcut isn't functioning, you can manually create a hyperlink by selecting the cell and pressing Insert > Hyperlink.



14.5
 
 
 
Add Drop-Down Menus




You'll sometimes use your spreadsheet to keep track of operations or other qualitative data. You should use dropdown menus to easily label descriptive items about your contacts or anything you're monitoring, rather than writing terms onto your sheet repeatedly, such as "Yes," "No," "Customer Stage," "Sales Lead," or "Prospect."



Here's how to make the cells drop-down menus.



Select the cells where you want the drop-downs to appear, then select Validation from the Data menu in the top navigation.



The Data Validation Settings box will appear after that. Check at the Allow choices, then select Drop-down List from the Lists menu. Select In-Cell from the dropdown menu, then click OK.



14.6
 
 
 
Using Pivot Tables to Organize and Understand Data




In a spreadsheet, to reorganize details, pivot tables are used. They won't modify the data, but they can add up values and compare relevant information in the spreadsheet if that's what you want.



For example. Let's say You want to see how many students are in each Hogwarts house. This trick will behelpful with larger data sets; go to Data > Pivot Table to make the Pivot Table. Excel can populate your Pivot Table for you automatically, but you can still rearrange the data. Then you have an option of four choices.



	
Report filter:
 This enables you to consider only a few rows of the dataset.


	
Column labels:
 These may be the headers of the dataset.


	
Row labels:
 These may be the rows of your dataset. Data from the columns can be carried by both Column and Row labels.


	
Value:
 The Value section allows you to take a different look at your data. Rather than just dragging in some numeric value, you can average, sum, count, and so on with your Data.





Go to the Pivot Table and move the House column for both Row Labels and the Values since You want to count the number of students in each house. This would add up the total number of students in each house.



14.7
 
 
 
How to Add a Strikethrough?




Users of MS Excel can frequently use the strikethrough option to confirm that a task is completed or checked off.



	
To incorporate a strikethrough, choose the cell to which the strikethrough style should be applied and click Ctrl+


	
If you wish to extend the strikethrough to a group of cells, select all of them and use the same workaround.




[image: ]



14.8
 
 
 
Easy Way to Make a Borderline of a Selected Cell




The easiest way to create the borderline of your cell is to use Excel shortcuts. Start by going through this process: Click Ctrl+shift+& to choose the zone you want to border.



14.9
 
 
 
How to Hide Rows and Columns With a Shortcut Key?




	
Select a cell in a row and click "Ctrl+9." Select a cell in a column and click "Ctrl+0" to hide it.


	
Select several cells and click Ctrl+9 to hide the columns and Ctrl+0 to hide a row to hide several columns and rows.




[image: How to hide row]


[image: How to hide collum]



14.10
 
 
 
Shortcut of the Auto Sum Without Typing or Using a Mouse




Usually, you select the region and then use the Auto sum to specify the amount, or YOU use the formula to finish the job. To get a total sum or number, choose the cell and click ALT+ Equal (=) to get a total sum or amount quicker and simpler.



14.11
 
 
 
How to Remove Duplicate Data Points or Sets?




There might be duplicate content in larger data sets, which is difficult to remove manually. Many times, you get a listing of multiple contacts, company numbers, products, etc. in such situations, you look for some shortcut for the removal of the duplicates to attain a perfect list, with no value repeating itself.



	
For removing all duplicates, highlight the column or row that you want to eliminate copies of.


	
Now, reach the data tab, and choose “Remove Duplicates” (under Tools).


	
You’ll see a confirmation pop-up concerning the data you want to work with.


	
Tap Remove Duplicates,” and that’s it!





14.12
 
 
 
How to Add a Checkbox in the Excel Sheet?




Are you looking to supervise anything that isn't quantifiable and uses an Excel sheet to track consumer data? In this case, checkboxes should be inserted into a column!



E.g., if you're using an Excel sheet to handle business prospects and want to keep track of whether you called them last quarter or not, you might add a "Called this quarter?" column and check off the cells that correlate to when you called the corresponding customer.



Let's have a look at how to do it in Excel.



	
In the spreadsheet, highlight a cell on which you want to add checkboxes.


	
Select DEVELOPER from the drop-down menu.


	
Choose the checkbox under FORM CONTROLS.


	
Until the box is visible in the cell, copy it.


	
Select the cells where you want them to appear. Now, you can paste it.





14.13
 
 
 
How To Hide a Whole Sheet?




There may be many worksheets in the file you're working on (each sheet is identified by a tab at the bottom, which you should name).



Rather than deleting it, you should cover it, which keeps the data available for reference and formulas on different sheets in your workbook.



	
Select “Hide” after right-clicking on the bottom sheet button.


	
To find it again, go to the View tab at the top of the page.


	
A list will appear after you tap Unhide.


	
Choose a name for your sheet, and that's all there is!





On the View tab menu at the left, there is also a Hide option. When you tap that, the whole workbook that you're using would be hidden. While it seems that you have closed the file, Excel continues to operate.



When you exit the app, it asks if you want to save all changes to the hidden workbook. Furthermore, as you open the file, Excel provides you with what seems to be a blank workbook until you select Unhide again.



14.14
 
 
 
Using Personal Workbook in an Excel Spreadsheet for Macros




You could see a workbook mentioned after unhiding up an entire workbook that you didn't even realize you had hidden. The Personal.XLSB file. It's the personalized Excel workbook you've created.



Whenever you launch your Excel, it will open as a secret workbook. But what exactly is the point of doing it? It's Macros. A macro gets bound to in whichever workbook you developed it. It won’t function through any single spreadsheet that you created by default (the way it does in word).



If you want to make a macro accessible in all of your spreadsheet files at all times, you must save it in Personal.XLSB.



While capturing the macro, select the “Personal Macro Workbook” only in the “Store macro in” section. To record a macro, open the Developers tab, go to the “File tab,” pick “Options,” tap “Customize Ribbon,” check “Developers” in the Main Tabs window, and then tap “OK.”



14.15
 
 
Excel's NTIF Function: Perfect for Counting Words or Numbers in Any Set of Cells




Instead of manually calculating how many times a certain amount or value occurs, it's a great idea to delegate the task to Excel. A number or word appears in a series of cells; Excel uses the COUNTIF feature to determine where it belongs. Let's say to determine how many times the word "Alexander" occurs in my data set.



The formula: =COUNTIF (range, criteria)



Here's the formula, which includes variables from the example: =COUNTIF (D:D, “Alexander”)



In this formula, there are many variables:



	
Range:
 This refers to the region that the applied formula can cover. Since you are focusing on one column in the current example, use "D:D" to indicate that the first and last columns are both D. “B:D” will be used iflooking at columns B and D.


	
Criteria:
 There is some text or sum of text that youwant Excel to count. Only use quotation marks if you want the findings to be in text form rather than a number.





Type the COUNTIF formula in either cell and click "Enter" to see the cumulative number of times the term "Alexander" occurs in the dataset.



14.16
 
 
 
Essential Shortcut Keys and Tips




Learning how to use shortcuts in Excel is one of the best Excel tips. Here are a few shortcuts you may not know about. Some of these are common to all Microsoft Office products (e.g., Word, PowerPoint, etc.), but they're especially useful in Excel.



	
Ctrl Z:
 This order undoes your last action in the worksheet. The backward arrow or the Ctrl Z keyboard shortcut in the top left corner of the Excel window can be used above the navigation menu.


	
Up or down arrow with Ctrl-Shift:
 Selects all cells immediately above or below the selected cell. It will only select the cells with data above and below it; it does not choose empty cells.


	
Shift F11:
 Generates a Newworksheet named "Macro1" in the existing workbook. The insert tab shortcut is another name for this shortcut. For this shortcut to function in Mac OS, you will need to use the Fn key.


	
Ctrl Home:
 Goes to A1 cell.


	
Ctrl End:
 Goes to the last data-containing cell.


	
Format Painter:
 Choose the cell you want to copy the format of. Then, on the Home page, press Format Painter (the tiny paintbrush) in the upper toolbar. Alternatively, in the pop-up file menu that occurs after right-clicking, press the paintbrush, then pick the cell you want to format.


	
Pivot table:
 It is a condensed version of the input data gathered precisely in charts that can be used to monitor and interpret data trends. Pivot tables are Excel tricks that enable you to create a detailed and multifaceted overview of thousands of rows and columns of unorganized data. You can assemble large amounts of data into a conveniently digestible spreadsheet by utilizing pivot tables. To quickly create a pivot chart, use the Excel keyboard shortcut Alt+N+V.









 
 
Conclusion









 The spreadsheet application called Microsoft Excel is used to manage numerical data, calculations, analysis, and prediction, all possible. So, what would you like to do with Microsoft Excel? In essence, it will enable you to perform some related tasks in the spreadsheet. When you open Excel, you're presented with a grid-like page. A worksheet is what this is called. All of your data would be saved here. A workbook is made up of several worksheets. Data is entered in single cells in the grid, which is made up of rows and columns. You would then calculate the value in one cell by the value in another cell.



The cells may be subjected to a variety of mathematical functions. Microsoft Excel can be used for various tasks; for example, you can create a table to track your monthly outputs. You'll be able to keep track of how much you spend per month if you do it this way. Alternatively, you might be working in a business setting and can use Excel regularly. In this situation, the spreadsheet applications can become complex, necessitating a high level of understanding. Engineering is another area where Excel can help make work simpler. You can use math functions to analyze your files. This may be as simple as adding up the numbers in a data column or as sophisticated as mathematical analysis. Excel also helps you to build your own servers. Anything dedicated to database management or Microsoft Access is a great option; since Excel is part of the MS Office range of programs, it may communicate with other applications included in the package. E.g., you might want to transfer data from Excel to MS Access or vice versa. Excel is a versatile platform that can be used at home or in the office.
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